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CHAPTER 1 INTRODUCTION

Purpose of This Manual
This manual is a guide for CAMIO engineers and administrators to installing, configuring, and 
administering the CAMIO MOS System, which normally includes 

•  CAMIO MOS server

•  Newsroom Computer System Client Workstations

•  Graphics Preparation Workstations

•  Lyric-based Playout Devices

This manual does not include operating instructions for the Newsroom Client, Graphics 
Preparation, or Playout Device Software. These instructions are available in the applicable 
Operator's manuals. 

Manual Organization
Here is a quick overview of the chapters in the manual.

•  CHAPTER 1 INTRODUCTION - gives the purpose of this manual, its 
organization, and customer support information.

•  CHAPTER 2 OVERVIEW - describes the CAMIO System.

•  CHAPTER 3 INSTALLING and CONFIGURING the NEWSROOM 
CLIENT (PRODUCER’S) WORKSTATION SOFTWARE - installation and 
configuration information is provided here.

•  CHAPTER 4 INSTALLING and CONFIGURING GRAPHICS 
PREPARATION WORKSTATION SOFTWARE - installation and 
configuration information is provided here.

•  CHAPTER 5 INSTALLING and CONFIGURING the Lyric-based 
PLAYBACK DEVICE SOFTWARE - Lyric-based playback device software 
installation and configuration information is provided. 

•  CHAPTER 6 CAMIO ADMIN TOOL UTILITY - describes the CAMIO 
Admin Tool Utility, and provides step-by-step instructions of important 
procedures.

•  CHAPTER 7 CAMIO ASSET MANAGER - describes the new CAMIO 
Asset Manager.

•  APPENDIX A INSTALLING CAMIO SOFTWARE UPDATES - provides 
the procedures you will need to update your software.

•  APPENDIX B INSTALLING and CONFIGURING CAMIO SERVER 
SOFTWARE - provides installation and configuration instructions.

•  APPENDIX C GLOSSARY - contains terms users need to understand 
the CAMIO MOS System and its operation.
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•  APPENDIX D CHANNEL ASSIGNMENT for LYRIC TEMPLATES in 
CAMIO - procedures for assigning default channel assignments are given.

•  APPENDIX E RESTORING from a BACKUP FILE - procedures for 
restoring from a backup file are given.

•  APPENDIX F CAMIO LEGACY ASSET MANAGER - describes the prior 
version of the CAMIO Asset Manager and gives installation instructions.

•  APPENDIX G MIME TYPES - a list of MIME types is provided.

Customer Support
For customer support, call 1-888-4-CHYRON (1-888-424-9766).
Visit the Chyron Website at www.chyron.com, for immediate access to our forums and 
knowledge base, and an array of documentation downloads and other information to assist you.
5



CHAPTER 2 OVERVIEW

STREAMLINE NEWSROOM WORKFLOW
CAMIO is the singular solution for newsroom operations that depend on accurate, lightning-fast 
exchange of information and graphics. With CAMIO integrated into the newsroom—see Figure 1, 
graphic operations are streamlined, and journalists and producers have unprecedented control 
over the look and content of news graphics. 

Integrated with MOS Newsroom Computer Systems (NCS) such as AP® ENPS®, Avid® iNews®, 
Dalet® OpenMedia and Samsung®, CAMIO transforms the graphics creation workflow by 
enabling journalists and producers to create and edit template-based text and graphics for real-
time playout on Chyron’s Lyric-based CG systems.

Figure 1  CAMIO Workflow
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EFFICIENT ASSET BROWSING and GRAPHICS PRODUCTION
Via our LUCI (Lyric Universal Control Interface) ActiveX® interface, an NCS user can, from a 
newsroom workstation, remotely access a library of templates from the CAMIO Server for quick 
page creation and update of text, graphics, and videos. Chyron’s powerful asset management 
tools, search engine, and visual browser make it easy to locate templates, images, and videos on 
a central server. Completed pages can be previewed in LUCI’s WYSIWYG interface, associated 
with a story in an ordered rundown on the NCS, and then automatically sent to a Playlist for 
playout to air. 

Changes in the rundown are quickly and automatically reflected in a Playlist on the system. 
Because journalists and producers are directly involved in the final output, there is far less 
opportunity for error, and they can quickly make last-minute changes without involving a graphic 
artist or Lyric-based operator. The LUCI ActiveX interfaces directly with the CAMIO Server, using 
Lyric to display thumbnail previews accompanied by comprehensive text descriptions and 
metadata. The Chyron Asset Manager makes it easy to organize and manage content based by 
show, topic, type, etc., from any PC on the network. Because the graphics are based on existing, 
reusable templates, images, and videos created by the graphics department, CAMIO speeds the 
production of pages, unifies channel branding, and eliminates the need for an artist to create each 
page for a news broadcast. This frees artists for other tasks and increases output of the graphics 
department.

CENTRALIZED ASSET MANAGEMENT
CAMIO uses its technology to integrate browsing, creation, editing and management of media 
assets. Since assets are uploaded to a single location, multiple workstations and newsrooms can 
all access the same assets.
7



CHAPTER 3 INSTALLING and 
CONFIGURING the NEWSROOM CLIENT 
(PRODUCER’S) WORKSTATION SOFTWARE 

LUCI INSTALLATION
INSTALLATION
LUCI Software can be installed locally at each workstation, or can be installed remotely using 
Actve Directory or PsExec. 

LOCAL INSTALLATION
1. Log-in to the Newsroom client workstation with an administrative account. 

2. Depending on the security levels of your internet browser, you may need to add the 
CAMIO server as a trusted site in the Internet settings of your browser. To do this:

a. From the Internet Browser menu, select Tools>Internet Options. The Internet 
Options dialog box opens.

b. Select the Security tab. Click on Trusted sites.

c. Click on Sites. The Trusted Sites dialog box is displayed.

d. Enter the following URL: http://<CAMIO_SERVER>, where <CAMIO_SERVER> is 
the network name of the CAMIO server.

e. Uncheck the Require sever verification (https) for all sites in this zone check 
box.

f. Click Add.

g. Close the Trusted sites and Internet Options dialogs.

h. Restart your Internet Browser.

3. Go to Installer Web page http://<CAMIO_SERVER>:8080/install.tsp, where 
<CAMIO_SERVER> is the network name of the CAMIO server.

4. Click on LUCI (Chymox ActiveX).

5. Click on RUN on the next two dialog boxes, to start Install Shield Wizard.

6. If an older version of LUCI is installed on your system, select Remove from the Modify, 
Repair, Remove dialog box that appears, to remove the old version of LUCI. 

7. Select No, do not restart computer, when prompted

8. Repeat installation steps 3 and 4.

9. Enter your CAMIO Server hostname when prompted, and click on Install.
8



REMOTE INSTALLATION

1. Log-in to the CAMIO Server with the CAMIO account.

2. Go to Installer Web page http://localhost:8080/install.tsp. 

3. Click on and follow the instruction for installing LUCI remotely using Active Directory or 
PsExec. 

CONFIGURING LUCI
Configuring LUCI comprises the following:

Using the CAMIO Admin Tool User Manager to:

•  Create a User. Set which tabs and asset details are visible in LUCI. See 
“CAMIO USER MANAGEMENT” on page 70, and follow the directions 
provided there.

Using the CAMIO Admin Tool MOS Manager to:

•  Specify how details of the assets are displayed in LUCI. See “CAMIO MOS 
MANAGEMENT” on page 46 and follow the directions provided there.

SETTING LUCI PREFERENCES
Refer to Setting LUCI Preferences in the CAMIO Producer’s Manual (Publication No. 2A02236, 
Rev A).
9



CHAPTER 4 INSTALLING and 
CONFIGURING GRAPHICS PREPARATION 
WORKSTATION SOFTWARE

INSTALLING LYRIC and ASSOCIATED TASKS
MINIMUM SYSTEM REQUIREMENTS
Before installing Lyric, be sure your system meets the following minimum requirements:

•  Windows® XP with Service Pack 2 or Windows Vista® operating system. If 
using Vista, then Lyric must either be RUN AS ADMIN, or USER 
ACCOUNT CONTROL must be set to OFF in order to have full 
functionality. Please note that RUN AS ADMIN provides greater security.

•  Intel® Core™ 2 Duo processor

•  nVidia® 8 or better series video card with minimum 512MB RAM

•  100GB drive space; physical or virtual drives should be configured to 
match the playout system to facilitate message and asset transfer.

•  2GB of RAM

•  Standard keyboard

INSTALLING LYRIC
ABOUT LYRIC SOFTWARE LICENSING

Important

Lyric 7 and the Lyric PRO option require the presence of a
Chyron-supplied dongle in the system in order to run.
Dongles that have enabled older versions of Lyric on
existing Chyron systems ARE NOT compatible with Lyric
Version 7. They must therefore be reprogrammed. Please
contact Chyron Customer Service at 631-845-2132 if you are
upgrading a Chyron system to Lyric Version 7. 

Newly-purchased Chyron systems include either Lyric Version 7 or the Lyric PRO option, as 
ordered by the customer, with the purchased options enabled. Therefore, no licensing updates are 
required.

•  To purchase and enable additional software options, please contact 
Chyron Customer Service. 

•  Newly purchased Lyric 7 Offline and Lyric PRO Offline packages include a 
dongle kit programmed with the appropriate options.
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 Full instructions for upgrading a Chyron 
system running a previous version of Lyric to Lyric 7 
or Lyric 7 PRO may be found in the Lyric 7 Release 
Notes, Chyron Document Number 2a02249.

To install Lyric:
1. Insert the installation CD in your CD-ROM drive.

2. Locate and double-click the Lyric setup icon on the installation CD.

3. Click on Next. The Chyron Welcome screen is displayed (Figure 2). Read the information 
provided there. 

Figure 2  Chyron Lyric Welcome Screen
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4. Click on Next. The Lyric License Requirements dialog box (Figure 3) 
appears.Click on Yes to continue with the installation.

Figure 3  Lyric License Requirements

5. The License Agreement window (Figure 4).

Figure 4  License Agreement
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6. After reading and accepting all the terms of the license, click on Yes. The Choose 
Destination Location window (Figure 5) is displayed.

Figure 5  Destination Folder

7. Click on Next to install Lyric in the selected folder, or click on Browse and select another 
folder. The Setup Type window (Figure 6) is displayed.

Figure 6  Setup Type
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8. Select the type of setup you prefer:

•  Custom—select the features you want to install

•  First Time User—have sample content installed with Lyric

•  Minimal—install Lyric and minimum supporting DLLs

•  Server—installs Lyric as a typical installation but registers the 
application as a Service

•  Typical— if you do not require sample content

9. Click on Next. The Select Program Folder window (Figure 7) is displayed.

Figure 7  Select Program Folder

10. Select a program folder. Click on Next. Lyric is now installed.
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11. After Lyric is installed, the SentineILM 6.2 Server Setup screen is displayed (Figure 8). 
Follow the on-screen instructions.

Figure 8  SentineILM Server Setup 

12. After installing the server, the Lyric Setup Complete screen is displayed (Figure 9).

Figure 9  Lyric Setup Complete
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13. Click Finish to complete the setup.

14. Next, install the Lyric MOS XML plug-in. This will add XML tags to all Lyric Messages 
saved on that version of Lyric (existing messages will need to be re-saved to get the XML 
tag).

INSTALLING the LYRIC MOS XML PLUG-IN

Important

This plug-in needs to be installed on each version of Lyric
that will be creating content that will be accessed by the
CAMIO server. 

To enable Lyric on the playout device to interpret and act on the MOS and XML information it 
receives from the CAMIO Server, the Lyric MOS XML plug-in and the MSXML4 dll must be 
installed on the playout system. 

The installation of the MSXML4 dll is 
performed automatically and is transparent to the user.
16



To install the Lyric MOS XML plug-in:

Important

The CAMIO Server must already be installed on the network
before you can install this plug-in.

1. Navigate to http://camioserver:8080/install.tsp, where camioserver is the name of the 
camio server.

2. Double-click on the Lyric MOSXML Plugin.exe icon.

3. The MOSXML Plug-in Welcome window (Figure 10) opens.

Figure 10  Welcome to Lyric MOS XML Plug-in Setup
17



4. Click Next. The Choose Destination window (Figure 11) opens.

Figure 11  Choose Destination

In the next step, be sure to install the files 
in the correct folder. 

5. Select the folder where the files will be installed based on the version of Lyric that will be 
used on this system to compose new Lyric messages.

6. Click Next, and follow the online instructions.
18



INSTALLING the NEW ASSET MANAGER
To install Asset Manager:

1. Open Internet Explorer.

2. Enter the following URL: http://<servername>:8080/assetmanager (8080 is the data 
connection port used by CAMIO and <servername> is the name of the CAMIO server). 

INSTALLING JAVA SE 6 (if not already installed)
Before installing JAVA, check If there is an older version of Java installed on the client PC. If there 
is, remove it to ensure that the proper version is loaded. 

To do this:

1. Open the Windows Control Panel. Double-click on Add or Remove Programs. The Add 
or Remove Programs dialog displays.

2. Check that the version of the Java Runtime currently installed is Java SE 6 Update 10. If it 
is not, remove it.

3. From the client workstation, log on to the CAMIO Server from Internet Explorer using the 
URL: http://<servername>:8080/assetmanager (8080 is the data connection port used 
by CAMIO and servername is the name of the CAMIO server). The CAMIO Server 
automatically loads the Java Runtime.

SETTING JAVA POLICY
To Set Java Policy for the new Asset Manager, perform the following procedures (Launching the 
Java Policy Tool, Adding the Policy Entry, Setting Permissions, and Saving the Policy 
Entry) in the order given.

Launching the Java Policy Tool:

1. On the workstation, locate the folder containing the highest revision of Java on the 
computer (c:\program files\Java\jre1.6.x\bin). Within that folder, locate the Java policy 
tool executable, policytool.exe, and double-click on it to launch the application. See 
Figure 12.

Figure 12  Java Policy Tool Executable
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2. A DOS Command window will display and the Policy Tool application (Figure 13) will 
open. The Policy Tool may display multiple entries, including an entry for the Legacy Asset 
Manager of the same CAMIO. This information may stay in the Policy Tool unchanged. 

Figure 13  Policy Tool
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Adding the Policy Entry:

1. Click on Add Policy Entry to create an entry for the CAMIO server. The Policy Entry 
dialog (Figure 14) will appear. 

Figure 14  Policy Entry Dialog

2. In the CodeBase field, enter the following string: 

http://<YOURCAMIOSERVER>:8080/assetmanager/AssetUploader.jar

where <YOURCAMIOSERVER> is the name of the CAMIO server to be used (note that 
other than the name of the CAMIO server, the path is case-sensitive).
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Setting Permissions:

1. Click on Add Permission. The Permissions dialog will appear (Figure 15). The 
Permissions dialog has three fields: Permission, Target Name, and Actions that are 
set using corresponding dropdown lists. A fourth field, Signed By, requires no entry.

Figure 15  Permissions Dialog

2. Set the three fields as follows (Figure 16):

a. In the Permissions field select FilePermission from the dropdown list. This will post 
java.io.FilePermission in the text box to the right of the Permission field.

b. In the Target Name field, select <<ALL FILES>> from the dropdown list. This will 
post <<ALL FILES>> in the text box to the right of the Target Name field.

c. In the Actions field, select read from the dropdown list. This will post read in the text 
box to the right of the Actions field.

d. Press OK to close the Permissions dialog and return to the Policy Entry dialog.

e. Click Done to return to the Policy Tool.

Figure 16  Setting Permissions
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Saving the Policy Entry:

1. In the Policy Tool, select FILE>SAVE AS or FILE>SAVE (if there is an existing Java Policy 
that is being added) from the main menu.

2. In the File Save As dialog, navigate to c:\Documents and Settings\<USER> (replace 
<User> with the user name on the computer currently in use). The file should be saved as:

.java.policy

Note the period before the word java in the 
above file name.

3. Click on Save to save the file with the proper name; close the Save As dialog box.

4. The JAVA Status dialog (Figure 17) will appear to indicate the success of the file save 
operation. Click on OK to accept the modifications to the Java Policy tool.

Figure 17  Java Status

5. Click on FILE>EXIT to close the Java Policy tool. 

6. Close any open browser windows and re-launch the browser. Log into the new Asset 
Manager (http://<yourcamioserver>:8080/assetmanager ). You should now be able to 
drag assets into the drop zone and begin the process of publishing them to CAMIO.
23



INSTALLING and CONFIGURING LUCI
INSTALLATION 
LOCAL INSTALLATION

1. Log on to the Newsroom client or art department workstation with an administrative 
account.

2. Depending on the security levels of your internet browser, you may need to add the 
CAMIO server as a trusted site in the Internet settings of your browser. To do this:

a. From the Internet Browser menu, select Tools>Internet Options. The Internet 
Options dialog box opens.

b. Select the Security tab. Click on Trusted sites.

c. Click on Sites. The Trusted Sites dialog box is displayed.

d. Enter the following URL: http://<CAMIO_SERVER>, where <CAMIO_SERVER> is 
the network name of the CAMIO server.

e. Uncheck the Require sever verification (https) for all sites in this zone check 
box.

f. Click Add.

g. Close the Trusted sites and Internet Options dialogs.

h. Restart your Internet Browser.

3. Go to Installer Web page http://<CAMIO_SERVER>:8080/install.tsp (where 
CAMIO_SERVER is the network name of the CAMIO Server).

4. Click on LUCI (Chymox ActiveX).

5. Click on RUN on the next two dialog boxes, to start Install Shield Wizard.

6. Select Remove from the Modify, Repair, Remove dialog box, to remove the old version 
of LUCI. 

7. Select No, do not restart computer, when prompted.

8. Repeat installation steps 2 - 4.

9. Enter your CAMIO Server hostname (same as <CAMIO_SERVER>, above) when 
prompted, and click on Install.
24



CONFIGURING LUCI
Configuring LUCI comprises the following:

Using the CAMIO Admin Tool User Manager to:

•  Create a User and set which tabs and asset details are visible in LUCI. See 
“CAMIO SCRIPT MANAGEMENT” on page 80, and follow the directions 
provided there.

Using the CAMIO Admin Tool MOS Manager to:

•  Specify how details of the assets are displayed in LUCI. See “CAMIO MOS 
MANAGEMENT” on page 46 and follow the directions provided there.

SETTING LUCI PREFERENCES
Refer to Setting LUCI Preferences in the CAMIO Producer’s Manual (Publication No. 2A02236, 
Rev A).
25



CHAPTER 5 INSTALLING and 
CONFIGURING PLAYBACK DEVICE 
SOFTWARE 

INSTALLING LYRIC
Refer to “INSTALLING LYRIC and ASSOCIATED TASKS” on page 10. Follow the directions 
provided there for installing Lyric.

GPI OVERVIEW
A GPI, or General Purpose Interface, provides Lyric with the ability to transmit and receive triggers 
for internal and external events. 

A GPI can have a wide variety of uses, among them:

•  Triggering a Playlist event

•  Triggering a Squeezeback Effect

•  Turning on and off a tally light

•  Releasing a Pause

•  Stopping/starting a Clock or Timer

A Global GPI can also be set to allow an incoming GPI pulse to read any Lyric file using the 
extension *.lyr. Message types saved with this extension include conventional Lyric files, as well 
as specialized Lyric messages such as SD Mixer messages, CMix messages and Macro 
messages, etc.

Important

When a GPI assigned to a specific event, such as to trigger a
Playlist step or trigger a Squeezeback Effect, make sure that
the same GPI is not also assigned as a Global GPI, as there
may be a conflict when the GPI or Global GPI is triggered.
Refer to Global GPIs for additional information.
26



GPI CONFIGURATION—LYRIC-BASED SD/HD
OVERVIEW
Lyric can control or be controlled by external devices such as tape machines, digital disk recorders 
(DDRs), and switchers. This is accomplished by using GPIs (General Purpose Interface triggers) 
or by the BVW Serial Digital Protocol via the RS-422 Serial Digital Interface. Such control inputs to 
Lyric-based systems from external sources can start and stop Clocks and Timers, execute an 
individual step within a Lyric Playlist, or release a programmed pause. In addition, GPI control 
outputs from Lyric-based systems can be used to trigger external devices such as keyers and tally 
lights.

Important

To enable GPI and/or RS-422 capability, Chyron's optional
RS-422 Serial I/O & GPI/O Board must be installed in the
Lyric-based SD/HD system. Call Chyron Customer Service
for information about this product. Refer to RS-422 Serial I/O
& GPI/O Board for details on installation and setup. If this
board is not present in the system, the GPI and Device tabs
are grayed out.

Setup
To access GPI setup:

1. From the Lyric Config menu, select Hardware. The Hardware Configuration dialog is 
displayed (Figure 18).

2. Click the Setup GPI tab.

Figure 18  Hardware Configuration Dialog—GPI Setup
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The parameters in the table below should be set to enable GPI capability.

Important

When a GPI assigned to a specific event, such as to trigger a
Playlist step or trigger a Squeezeback Effect, make sure that
the same GPI is not also assigned as a Global GPI, as there
may be a conflict when the GPI or Global GPI is triggered. 

Item Description

GPI list box The GPI list box designates which GPI is assigned to a 
specific event. The number of GPIs available depends on 
the number of RS-422 Serial I/O & GPI/O boards installed 
in the system. In the GPI dropdown list box, default GPIs 
1-8 for the first installed RS-422 Serial I/O & GPI/O Board; 
9-16 for the second board; 17-24 for the third board, and 
25-32 for the fourth board. Click on the up or down arrow 
spin control box to set.

If multiple RS-422 Serial I/O & GPI/O boards are installed 
in the system, then the DIP switches must be correctly set 
in order to ensure availability of all GPIs.

Description field A descriptive name can be assigned to the GPI in the 
Description field for easier identification.

Direction field The Direction setting determines whether the designated 
port is to receive the incoming pulse (INPUT) or send an 
outgoing pulse (OUTPUT).

From Board display From Board indicates which Lyric-based LE/LEX/PCI/
PCI+ board originates or receives the GPI pulse.

GPIO Number display GPIO Number displays the pin combination to be used on 
the Lyric-based LE/LEX/PCI/PCI+ board’s GPI/O “D” con-
nector. 

Pulse Width Pulse Width defines the minimum duration of the GPI 
pulse in milliseconds. This should be set to ignore a short 
accidental contact with a physical GPI button or a slight 
signal anomaly that could unintentionally trigger the GPI.

Current Assignment 
Display

Indicates what operation the GPI is currently assigned to.   
For example, if GPI 5 triggers squeezeback effect #2, it 
will be indicated in this box. Note that 'temporary' assign-
ments, such as GPI pauses in the current message, are 
not indicated. 
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SETUP GPI–VPBS ONLY–Lyric-Based LE/LEX/PCI/PCI+
Each Lyric-based LE/LEX/PCI/PCI+ VPB includes a facility for 16 GPI (General Purpose Interface) 
connections per video channel. 

Important

The Setup GPI facility in the Lyric-based LE/LEX/PCI/PCI+ is
not available to PCI-Squeezeback boards; however, GPIs set
up from other boards can be used to trigger Squeezeback
effects. Additionally, the SQZ Kwik Tool must be enabled in
order that the GPIs trigger Squeezeback effects. 

To perform GPI setup:

1. From the Lyric Config menu, select Hardware. The Hardware Configuration dialog is 
displayed (Figure 19).

2. Click the Setup GPI tab.

Figure 19  Hardware Configuration Dialog
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The following parameters should be set to enable GPI capability:

3. After setting GPI parameters, click OK,

4. Close Lyric, then relaunch Lyric in order to apply GPI settings.

Important

When a GPI assigned to a specific event, such as to trigger a
Playlist step or trigger a Squeezeback Effect, make sure that
the same GPI is not also assigned as a Global GPI, as there
may be a conflict when the GPI or Global GPI is triggered. 

Parameter Description

GPI list box The GPI list box designates which GPI is assigned to a spe-
cific event. The number of GPIs available depends on the 
number of RS-422 Serial I/O & GPI/O boards installed in the 
system. In the GPI dropdown list box, default GPIs 1-8 for the 
first installed RS-422 Serial I/O & GPI/O Board; 9-16 for the 
second board; 17-24 for the third board, and 25-32 for the 
fourth board. Click on the up or down arrow spin control box to 
set.

If multiple RS-422 Serial I/O & GPI/O boards are installed in 
the system, then the DIP switches must be correctly set in 
order to ensure availability of all GPIs.

Description 
field

A descriptive name can be assigned to the GPI in the 
Description field for easier identification.

Direction field The Direction setting determines whether the designated port 
is to receive the incoming pulse (INPUT) or send an outgoing 
pulse (OUTPUT).

From Board 
display

From Board indicates which Lyric-based LE/LEX/PCI/PCI+ 
board originates or receives the GPI pulse.

GPIO Number 
display

GPIO Number displays the pin combination to be used on the 
Lyric-based LE/LEX/PCI/PCI+ board’s GPI/O “D” connector. 

Output Pulse 
Width 

Output Pulse Width defines the minimum duration of the GPI 
pulse in milliseconds. This should be set to ignore a short 
accidental contact with a physical GPI button or a slight signal 
anomaly that could unintentionally trigger the GPI.

Current 
Assignment 
display

Indicates what operation the GPI is currently assigned to.   For 
example, if GPI 5 triggers squeezeback effect #2, it will be 
indicated in this box. Note that 'temporary' assignments, such 
as GPI pauses in the current message, are not indicated. 
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GLOBAL GPIs
This facility allows an incoming GPI pulse to read any Lyric file using the extension *.lyr. Message 
types saved with this extension include conventional Lyric files, as well as specialized Lyric 
messages such as SD Mixer messages, CMix messages and Macro messages.

To assign Global GPIs:

1. From Lyric’s Config menu, select Hardware.

2. Click on the GPI tab (Lyric-based SD/HD systems) or the Setup GPI tab (Lyric-based LE/
LEX/PCI/PCI+ systems).

3. Set up and allocate one of the available GPIs. 

4. If you wish, enter a Description in the Description field.

Important

Make sure that the GPI that is assigned as a Global GPI is not
already assigned for use in another capacity (for example, in
a Playlist or to trigger a Squeezeback effect), as there may
be a conflict when the GPI or Global GPI is triggered. 

5. Click OK.

6. Return to the Config menu and select Global GPIs to open the Configure Global GPIs 
dialog (Figure 20).

Figure 20  Configure Global GPIs Dialog
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7. Double-click the entry for the GPI that you allocated in step 2. The Select File To Assign 
To GPI 1 dialog opens (Figure 21).

Figure 21  Select File To Assign To GPI 1

8. Select the file that is to be opened by the incoming GPI pulse.The Configure Global GPIs 
dialog reappears as shown in Figure 22. Note that the GPI assignment is labeled with the 
Description entered in step 2. This user-defined description on the left is not to be 
confused with the actual file path on the right-hand side of the entry.

Figure 22  GPI 1 Set as Global GPI
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9. Click OK. The selected *.lyr file will now open when the GPI is triggered.

10. If the Lyric file read by the GPI contains an animation, it is necessary to set playback 
parameters.

11.  From the Config menu, select Preferences, then the Animation Settings tab.

12. To play the animation immediately when read, select (check) AutoPlay On Read and 
deselect (uncheck) Prompt to Play on Lyric-based systems. The animation plays when 
read, without Lyric generating a prompt confirming playback. To manually trigger playback, 
deselect (uncheck) AutoPlay On Read.

Making the above settings effect all messages played out via Lyric,
including those messages from newsroom rundown Playlists.

13. Click OK to close Preferences.

14. Exit Lyric, then relaunch Lyric to apply the Global GPI settings. 

After parameters are set, Lyric must be closed and relaunched in order
to apply GPI settings.
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SETTING UP and USING LYRIC PLAYBACK CONTROL under 
MOS
GETTING STARTED
The playback machine requires a license for the Lyric XML plug-in. This license is available as 
Chyron part number 5A11394. One playback license is included with each CAMIO server.

INSTALLING PLAYBACK CONTROLLER SOFTWARE INTO LYRIC
The XML plug-in can be downloaded from the CAMIO server. Use the following link:

http://<CAMIO_SERVER>:8080/install.tsp

Click on Lyric MOS XML plugin and follow directions. Make sure that the plug-in is installed into 
the plugin directory of the Lyric software that is used for playback. A sample path would be: 
C:\Program Files\Chyron\Lyric 6.1\Plugins.

DISABLING the MODAL SUPPRESSOR
When the XML plugin is installed, the Modal Suppressor feature is enabled by default. The Modal 
Suppressor feature causes all Lyric modal dialog boxes to be suppressed. In this manner, Lyric 
can run unattended without hanging up on a status message that requires an operator to act upon. 
It is desirable to leave this feature enabled, if the system is operating under automation or GPI 
control. However, if there is an operator monitoring the system, the Modal Suppressor feature may 
also cause an operator to miss important Lyric status information. In this case, it is desirable to 
disable the Modal Suppressor feature by selecting Tools>Modal Suppressor>Disable Modal 
Suppressor?>Yes.

PLAYLIST
The Playlist feature allows multiple Lyric messages to be compiled into an automated list and 
played out sequentially using preset transition effects. For example, a Playlist could be used to 
automatically play a dissolving sequence of graphics displaying sports statistics.

A Playlist can consist of up to 500 preset events that are numbered from 0 - 499. Each event 
specifies the playout parameters of a Lyric message, including file name and transition effect. 
When a message completes playout, the Playlist proceeds to the next specified message. 
Simultaneous In and Out transition effects can be executed on Lyric-based systems.

When used in conjunction with the powerful CAMIO newsroom application, a Playlist can be 
remotely built and edited. Messages can be created on remote PCs and sent to the Lyric-based 
system where they are added to a Playlist for execution. When a Lyric Playlist is used in 
conjunction with a CAMIO (MOS) driven running order, updates to the Lyric Playlist do not occur 
while a graphic on either output of Lyric is in a paused state.

The next update to the Playlist will happen when the next update to the running order happens and 
Lyric is not is a paused state.
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OPENING a MOS PLAYLIST
1. Start Lyric.

2. Select Running Orders... from the Tools menu. The Playlists dialog is displayed (Figure 
23).

Figure 23  Playlists Dialog

3. Select a MOS Running Order from the displayed list by clicking on it. A MOS Playlist 
(Figure 24) will be displayed.

If there is only one running order (as shown in Figure 23), it should 
automatically cause the MOS Playlist to be displayed.

Figure 24  MOS Playlist
35



PLAYLIST LAYOUT
The Playlist is composed of a list of messages to be played out and the parameters that control the 
playout of each of them. 

To the right of the list are execution controls, as well as Timecode setup. Playlists can be 
composed on a PC for later use on a Lyric-based system. The Playlist can be resized by dragging 
any corner or edge. An individual column can also be resized by dragging the column separator in 
the heading.

Figure 25  Playlist

NAVIGATING the PLAYLIST
Use the following methods to navigate through the Playlist:

•  Press the  keys on your keyboard to navigate up, down, 
left, and right. 

When using the  keys to navigate, and 
the cursor reaches a field that accepts text entry, 
the cursor steps through the text before 
proceeding to the next field.

•  When the cursor is in a Line, Control, Effect, or Channel field, 
press Page Up or Page Down on your keyboard to navigate up or 
down in five-line increments. If the cursor is in the Line column, the 
entire line is highlighted.

•  In the Scroll Bar, click above or below the scroll box to page back-
wards or forwards, respectively, through the Playlist.

•  In the Scroll Bar, click the up or down arrow to scroll the Playlist one 
line up or one line down, respectively.

•  Press End on your keyboard to move the cursor to the next 
instance of End or to the final line of the Playlist that contains an 
entry.

The Playlist scrolls based on a fixed number of lines or a percentage. This value is set in the 
Playlist Configuration dialog box, which is accessible from the Playlist dialog.
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CURRENT MESSAGE ON OUTPUT Indicator
The Current Message On Output indicator (Figure 26) in the Playlist is indicated by the green 
square located at the left side of the Playlist.It identifies the currently displayed message in the 
Playlist During playout, this indicator proceeds line-by-line through the Playlist.

During Playlist execution, the Playlist automatically scrolls to display upcoming events.

CURRENT TAKE LINE Indicator
The Current Take Line indicator (Figure 26) in the Playlist is indicated by the red square located 
at the left side of the Playlist. It identifies the Playlist line that will be executed next. When a step is 
executed, the Current Message On Output Indicator moves to the same line as the Current 
Take Line indicator (the two indicators are briefly positioned on the same line). The Current Take 
Line indicator then moves to the following line.

Figure 26  CURRENT MESSAGE ON OUPTPUT and CURRENT TAKE LINE 
Indicators

In the event that non-sequential execution of the Playlist is necessary, the Current Take Line 
indicator can be moved to a different step using one of the following methods:

•  Click to the left of a line to move the Current Take Line indicator to 
that line.

•  Press Ctrl + (up arrow) or Ctrl + (down arrow) to move the Current 
Take Line indicator up or down in one-line increments.

•  Press Ctrl + Page Up or Ctrl + Page Down to move the Current 
Take Line indicator up or down in five-line increments.

•  Press Ctrl + Home to move the Current Take Line indicator to the 
first line of the Playlist.

•  Press Ctrl + End to move the Current Take Line indicator to the 
next instance of End or to the final line of the Playlist that contains 
an entry.

•  Trigger a GPI to move the Current Take Line indicator up or down 
in one-line increments. The GPI is set up in the Playlist Configura-
tion dialog box. A GPI can also be used to execute a Take.
37



Line
The number in the Line column identifies the line number for each event or step on the Playlist. 
The terms line and step are used interchangeably in reference to Playlists in this documentation. A 
Playlist can contain up to 500 steps, numbered from 0 - 499. 

Playlist Autopositioning
Playlist Autopositioning is an innovative feature that is unique to Chyron's MOS solution. If the 
MOS Playlist is changed by the NRCS, even after playback has started, the Playlist 
Autopositioning feature will seek to keep the Green Air and Red (Preview) grommets pointing to 
the correct objects in the Playlist according to the following simple rules. 

These rules were developed to account for common last minute
newsroom changes. They particularly look for changes made on the
story level—entire stories being added or dropped, which is common in
live news production. 

•  Rule One: If objects are added or deleted either before or after the 
message cued into the preview canvas, the preview grommet will 
move up or down to stay pointing at the previously cued message. 
See Rule 4, CUE BACK option, for a description of an exception to 
this rule. The air grommet will always point to the on-air message. 

•  Rule Two: If the message that is cued into the canvas preview is 
changed for any reason (typo corrected by the NRCS or position 
change, for example), the Take button will turn red, requiring a Take 
to re-cue the corrected message.

•  Rule Three: If the entire story of the message cued into the canvas 
preview is floated/deleted by the NRCS, the preview grommet will 
re-position to the start of the next story in the Playlist.   

•  Rule Four: (CUE BACK option, must be selected in the Settings 
window). If a story is inserted directly in front of the story currently 
on air, the Playlist will assume that this is a "breaking news story", 
and it will place the preview grommet back to the top of that new 
story. 
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PLAYLIST CONFIGURATION SETTINGS 
The configuration settings, as implemented by Select Playlist, Refresh Playlist, and Auto 
Refresh, control how the Playlist operates. See Figure 27.

Figure 27  Playlist Configuration Settings

Select Playlist If more than one Running order is published by the NRCS at a time, use the 
mouse to select the desired Playlist from the available list and click on SELECT Playlist to load it 
into the Lyric Playlist. If only one playlist is available, it will load automatically.

Refresh Playlist The Refresh Playlist button requests a Running Order Update from the 
CAMIO server. This can take between 10-15 seconds to execute under some circumstances.

Auto Refresh (normally checked) Checking this box keeps the Lyric Playlist connected to the 
MOS newsroom system. It receives any changes on the fly. Uncheck this if you want to disconnect 
the Playlist window from the MOS newsroom system. 

Listening (display only) This display shows the status of the connection between Lyric and the 
MOS Server. It is a useful debugging tool if you suspect that communication has been lost with the 
server. 
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OPERATING the PLAYLIST
The playback controls, Play, Take, and Stop are located in the upper right corner of the MOS 
Playlist dialog (Figure 28).

Figure 28  Playback Controls

TAKE
The Take button is the one usually used in MOS applications. The TAKE button manually cues 
and plays each Playlist item in sequence. Note the color of the TAKE button, it changes to green 
when a message is cued and ready to air. Also note the red and green "grommets" along the left 
edge of the Playlist (Figure 29). They indicate which message is on air (green) and which one is 
cued in the preview canvas (red).   

Figure 29  MOS Playlist
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When the Take button is red, clicking it reads the next message in the Playlist to the preview 
canvas, but does not affect the air channel. When the Take button is green, clicking it brings the 
message in the preview canvas to air. Following this, it reads the next message to the preview 
canvas. 

The following sequence empirically describes operation of the Playlist.

• Preview and air grommet on Line 0, Take is red

• Starting position, no message on air and none in the canvas

•  Click Take

• Preview and air grommet on Line 0, Take is green

• Message 0 get read to the preview canvas

• Take button turns green signaling that the message in the preview canvas is ready 
to take to air

•  Click Take

• Preview grommet on Line 1

• Air grommet on Line 0

• Message 0 plays to air

• Message 1 gets read to the preview canvas

• Take button remains red until message 1 gets read to the preview canvas and then it 
turns green signaling that Message 1 is ready to go to air

•  Click Take

• Preview grommet on Line 2

•  air grommet on Line 1, 

•  Message 1 plays to air

•  Message 2 gets read to the preview canvas

• Take button remains red until Message 2 gets read to the preview canvas and then it 
turns green signaling that Message 2 is ready to go to air. 

This cycle continues for the duration of the Playlist.

If for any reason the Playlist is modified so that a different message
should go to air other than the message in the preview canvas, the
TAKE button will turn red, forcing a re-read of the next message in the
Playlist. 

TAKE operation can be controlled by mouse click on the Playlist’s TAKE button, a keyboard 
shortcut key (normally F5), or by a GPI trigger. These options are set up in the Playlist 
Configuration dialog. Refer to Lyric on-line Help.
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The Play button automatically cycles through all the items in the
Playlist using the CONTROL parameter to trigger each message. This
control is not usually used in MOS news production applications.
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NOTES:
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CHAPTER 6 CAMIO ADMIN TOOL UTILITY

GETTING STARTED
OPENING the CAMIO ADMIN TOOL UTILITY

To open the CAMIO Admin Tool Utility, do one of the following:
•  From any machine connected to the CAMIO Server over the network, open 

an Internet browser, and then enter http://<CAMIO_SERVER>:8080/
CAMIO/Diagnostics/, where <CAMIO_SERVER> is the name of the 
CAMIO Server. 

or

•  From the CAMIO Server's start menu, select Programs> Chyron>Admin 
Tools>CAMIO administrator.

 The CAMIO Admin Tool Sign In window (Figure 30) is displayed. 

Figure 30  CAMIO Admin Tool—Sign In

1. Upon initial entry, the user is prompted to log in. Depending on the security levels of your 
internet browser, you may need to add the CAMIO server as a trusted site in the Internet 
settings of your browser. To do this:

a. From the Internet Browser menu, select Tools>Internet Options. The Internet 
Options dialog box opens.

b. Select the Security tab. Click on Trusted sites.

c. Click on Sites. The Trusted Sites dialog box is displayed.

d. Enter the following URL: http://<CAMIO_SERVER>.

e. Uncheck the Require server verification (https) for all sites in this zone check 
box.
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f. Click Add.

g. Close the Trusted sites and Internet Options dialogs.

2. Enter admin (initial default user name) in the User field. 

3. Enter admin (initial default password) in the Password field. 

4. Click on Sign In!. The CAMIO Admin Tool Utility screen (Figure 31) is displayed.

Figure 31  CAMIO Admin Tool Utility
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CAMIO MOS MANAGEMENT
GETTING STARTED
Using the CAMIO MOS manager, NCS servers, backup NCS servers, Playlist Defaults, and other 
settings may be configured.

To access the CAMIO MOS Manager:
1. Start the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 

page 44.

2. Select MOS (Figure 32)from the left navigation panel. 

Figure 32  Selecting MOS
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3. The MOS Management page (Figure 33) opens in the simple view. In most cases, the 
simple view is sufficient for configuring MOS. In some instances, however, it may be 
necessary to access the Advanced View for more comprehensive configurations. See 
“ADVANCED VIEW” on page 48.

Figure 33  MOS Management Page

CONFIGURING the MOS MANAGER
To configure the MOS Manager:

1. Select the News Room Computer System (NRCS) Type (ENPS, iNews, Dalet, etc), from the 
Server Type drop-down list box.

2. Enter the CAMIO alias of the CAMIO Server in the MOS ID field. If this field is left blank, 
CAMIO Server assumes that the MOS ID (alias) is the same as the CAMIO Server name.

3. Enter the NCS ID of the ENPS NCS Server or the iNEWS Server. If this field is left blank, 
CAMIO Server assumes that the NCS ID is the same as the NCS Server name. This field 
should duplicate the entry in the NCS Server field for INews. For ENPS this field should 
indicate the name assigned to the CAMIO Server in the MOS Configuration of ENPS.

4. Enter the Hostname or IP Address of the ENPS NCS Server or the iNEWS Gateway in the 
NCS Server field.

5. Enter the Hostname or IP Address of the backup NCS Server in the Backup NCS Server 
field.

6. Click the Submit button, to save settings.
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ADVANCED VIEW
The Advanced View provides additional setup options. To access the Advance View, click 

. The following menu options (Figure 34) are provided: MoreAdvanced, LUCI 
Client Configuration, Playlist Defaults, Asset Details, Auxiliary, and Playback Host. Each of 
these menu items are described below.

Figure 34  CAMIO MOS Management—Advanced View Menu Items
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MOREADVANCED
Selecting MoreAdvanced exposes the options shown in Figure 35.

Figure 35  MoreAdvanced Menu Options
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Refer to the table shown below, for a description of the MoreAdvanced options.

MORE ADVANCED MENU OPTIONS

Parameter/Setting/
Function Description

Persistence Mode Specifies if the Running Order should persist between CAMIO 
Server restarts.

• If Persist is selected, the Running Order persists when the CAMIO 
Server is restarted.
• If No Persist is selected, the Running Order does not persist when 
the CAMIO Server is restarted.

MOS Abstract Specifies the format for the MOS Abstract as shown in a Script. See 
“ASSET FORMATTING” on page 57.

Slug Specifies the format for the Slug as shown in the code that describes 
the MOS Object. See “ASSET FORMATTING” on page 57.

Running Order Specifies whether or not CAMIO will try to synchronize itself with the 
configured MOS Server.

• If Auto Sync is selected, CAMIO will automatically try to synchro-
nize itself with the configured MOS Server.
• If Manual Sync is selected, CAMIO will not automatically try to syn-
chronize itself with the configured MOS Server.

Default Edit New Sets the default when editing a previously created CAMIO Object to 
save the changes to a new page. The original file will not be overwrit-
ten with the modification.

Default Edit Replace Sets the default when editing a previously created CAMIO Object to 
save the changes to the original message number, overwriting the 
original permanently. 

roChannel Override Specifies if roChannel overrides itemChannel in the roCreate or 
roReplace MOS message. Selecting True will cause roChannel to 
override itemChannel.

Socket Persistence Specifies if the socket connection initiated by CAMIO with the NCS 
server is kept active. Selecting True maintains the socket connection.

Cache Objects Expire 
After:

Enter a value for the number of days before an item moves into "Sec-
ondary Cache" — the default value is 90 (DAYS).
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LUCI CLIENT CONFIGURATION
Selecting LUCI Client Configuration exposes the options shown in Figure 36.

Figure 36  LUCI Client Configuration Menu Options
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The menu options are described in the table below.

LUCI Client Configuration

Proximity Will Be Used Specifies if the Proximity ActiveX interface will be used with the LUCI 
ActiveX interface on each client machine. Requires the Proximity 
ActiveX interface to be installed on the client machine.

OMS Host Specifies hostname of OMS (Order Management System) server. 
Proximity must be set to FALSE.

Axis Partial URL Specifies partial Axis URL starting with http:// and ending only with 
the Login and Password arguments.

Default Unicode Font Specifies the default Unicode font to be used by the client machines.

Asset refresh Interval 
(ms)

Specifies the time interval (in milliseconds) used by LUCI to poll for 
asset database changes.

Auto Erase Text During 
Playout

Specifies if blank text fields in LUCI result in blank text fields being 
played to air.

Prevent Running Order 
Editing

Specifies if LUCI should allow users to save changes made to objects 
when the Running Orders tab is active. With this set to false, the 
LUCI client will not offer a save button on the Running Orders page.

Suppress “Config 
Save” Warning

Specifies if LUCI should suppress the warning: Can’t save configu-
ration. Administrator may have made recent changes.

INews Studio Default value is True.

INews Insert Script Default value is Alt + Cntrl + F1.

INews Save Script Default value is Alt + Cntrl + F2.

INews Star Script Default value is Alt + Cntrl + F3.

INews Switch Script Default value is F4.
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PLAYLIST DEFAULTS
Selecting Playlist Defaults exposes the options shown in Figure 37.

Figure 37  Playlist Defaults Menu Options

The Playlist Defaults, described in the Playlist Defaults table on page 54, determine how 
messages played to Air from the Playlist are to be executed. The Playlist Defaults also specify 
accompanying information about the messages that are displayed in the Playlist. The Width 
column specifies the width, in pixels, of the column displaying the specified information. The Index 
column specifies the position of the column within the Playlist, starting from the left. A value of 0 
indicates that the column is hidden, but does not affect how the Default setting is applied. For 
example, the Parameter column can be set to not display; however, any Parameter that is 
specified is still applied to the Control
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PLAYLIST DEFAULTS

Control Specifies the default Playlist Control. The Control determines the trig-
ger that sends the message to Air.

Parameter Specifies the default Playlist Parameter for the specified Control. For 
example, if a delay is specified, the Parameter could be 00:00:00:15, 
indicating that there should be a half-second delay before the mes-
sage plays to Air. Not all Controls have an accompanying Parameter.

Channel Specifies the default channel in which the messages in the Playlist 
should play to Air. 

Effect Specifies the default effect to be applied to the messages in the Play-
list when they play to Air.

File Name This is a read-only field that can be displayed in the Playlist. It identi-
fies the file name and filepath of the message.

Page Page is a dynamic Playlist field. The specified name is used as the 
column header name and the Value field reflects the format used to 
calculate the values for the column's data. See “ASSET FORMAT-
TING” on page 57.

The settings shown in the figure are suited for ENPS.
The following is a recommended setting for iNEWS:

%["([^@]*) *@ *(.*)" "%{../storySlug}" "\\1"]

The ampersand represents the story or page delimiter in the iNEWS 
Gateway mosconfig.xml file.

Slug Slug is a dynamic Playlist field. The specified name is used as the 
column header name and the Value field reflects the format used to 
calculate the values for the column's data. See “ASSET FORMAT-
TING” on page 57.

The settings shown in the figure are suited for ENPS. The following is 
a recommended for iNEWS:

 %["([^@]*) *@ *(.*)" "%{../storySlug}" "\\2"]

Blank Fields These are dynamic Playlist fields. The specified names are used as
the column header names and the Value fields reflect the format used
to calculate the values for the columns' data. Formatting is covered
following this table.
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ASSET DETAILS
Selecting Asset Details exposes the options shown in Figure 38.

Figure 38  Asset Details Menu Options

Refer to the table shown below, for a description of Asset Details options.

Messages Specifies the format for the Asset Details of the Messages. See
“ASSET FORMATTING” on page 57. This is how the details of the
asset will be displayed in the LUCI plug-in.

Images Specifies the format for the Asset Details Images. Formatting is cov-
ered following this table. This is how the details of the asset will be
displayed in the LUCI plug-in.

Videos Specifies the format for the Asset Details Videos. This is how the
details of the asset will be displayed in the LUCI plug-in.

XClyps Specifies the format for the Asset Details XClyps.

Running Orders Specifies the format for the Asset Details Running Orders. See
“ASSET FORMATTING” on page 57. This is how the details of the
asset will be displayed in the LUCI plug-in.
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AUXILIARY PLAYBACK HOST
Selecting Auxiliary Playback Host exposes the options shown in Figure 39.

Figure 39  Auxiliary Playback Host Menu Options

Running Orders can be sent to an Auxiliary Playback system. Information regarding the system is 
specified in the Auxiliary Playback Host settings. The Auxiliary Playback Host items are described 
below.

Hostname Specifies the Hostname or IP Address of the Auxiliary Playback Sys-
tem that is sent the Running Orders.

Port Specifies the Port on the Auxiliary Playback System that listens for
Running Order updates. Note that the Port on the Auxiliary Playback
System must be set to receive the Running Order updates. 

XSL Stylesheet Stylesheet that specifies an XSL Translation that converts the Run-
ning Order XML before it is sent to the Auxiliary Playback System.
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ASSET FORMATTING
The information displayed about an asset in LUCI is determined by the formatting set in the Asset 
Details section of the CAMIO MOS Manager (Advanced View must be selected to access the 
Asset Details section). 

The identifier for a data element always starts with a % sign. The following table provides the 
format strings for the data elements.

FORMAT STRINGS

Format 
String Data Element

%T The Title of the asset

%A The Author of the asset

%D The Description (comments) of the asset

%K The Keywords of the asset

%F The Filename of the asset

%S The Subject of the asset

%P The Asset Class Moniker of the asset. Every asset belongs to an 
Asset Class that is a virtual directory folder for assets. The virtual 
directory tree exists in the Lyric database (*.mdb) file, and can be 
viewed or browsed through Chyron's AssetManager tool. The Asset 
Class Moniker is simply the user-friendly name of the virtual folder.
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The information displayed in the Playlist, MOS Abstract (the code that specifies the MOS Object in 
a Script), and Slug (the code that specifies the MOS Object) is determined by the formatting set in 
MOS Administration. The identifier for a data element always starts with a % sign. The following 
table provides the format strings for the data elements.

FORMAT STRINGS

Format String Data Element

%ad The Duration for Automation (in Timecode format) of a MOS Object

%as The Start Time for Automation (in Timecode format) of a MOS Object

%m The message number of the MOS Object

%t The Filename of the Template which the MOS Object was created

%s The exact Slug as entered by the user in the Slug input field in the LUCI

%o The Object ID of the MOS Object

%g The story Slug of the MOS Object

%c Channel assignment of MOS Object

%% An explicit percent (%) character

%0 The first text field's text data in the MOS Object content

%1 The second text field's text data in the MOS Object content

%2 The third text field's text data in the MOS Object content

%3 The fourth text field's text data in the MOS Object content

%4 The fifth text field's text data in the MOS Object content

%5 The sixth text field's text data in the MOS Object content

%6 The seventh text field's text data in the MOS Object content

%7 The eighth text field's text data in the MOS Object content

%8 The ninth text field's text data in the MOS Object content

%9 The tenth text field's text data in the MOS Object content

%* Same as "%0 %1 %2 %3 %4 %5 %6 %7 %8 %9"

%( ### %.) Repetitively emits the text content in between the opening and closing paren-
theses, once for each piece of text data in the MOS Object content, where 
the current iterative text data replaces the "%". For example, if the MOS 
Object's text data are as follows:

Transit Strike
Monday, November 24, 2003
City Hall

Then the resulting text is as follows:

 ### Transit Strike ### Monday, November 24, 
2003 ### City Hall
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%. Used in conjunction with %(). See %( ### %.) above

%(%.)(15) Similar to the above %(), but places a maximum iterative limit. In this exam-
ple, the iterated text cannot exceed fifteen, even if there are sixteen or more 
pieces of text data in the MOS Object.

%{relative 
xpath notation}

The text content of the Running Order's MOS XML's <roCreate> tree's XML 
element specified by the relative xpath notation. The xpath notation is relative 
to the <item> element of the element tree. For example, to display the Story 
Number associated with the MOS Object item, the xpath notation would be: 
../storyNum

FORMAT STRINGS

Format String Data Element
59



CAMIO DEVICE MANAGEMENT
PRELIMINARY

1. Start the CAMIO Admin Tool utility. See “OPENING the CAMIO ADMIN TOOL UTILITY” 
on page 44.

2. Select Device from the left navigation panel (Figure 40). 

Figure 40  Selecting Device

3. The CAMIO Device Manager (Figure 41) opens.

Figure 41  CAMIO Device Manager
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SPECIFYING the DEVICE
1. Select New Device from the Select Device drop-down list box (Figure 40, page 60).

2. Enter a Device Alias in the Device Name field. The Device name does not have to match 
the computer name that is defined in the Playout hostname. The device name is how the 
machine is referenced in the context menu channel assignment fields. When a Device 
Name is entered, the Playout Folder field is automatically populated with the name of the 
folder on the Playout Hostname system where the rendered Template Data Messages 
are saved. This occurs by default. However, the folder name can be changed prior to 
submitting the new device settings.

Important

The Playout Folder, to which the Template Data Messages
and images substituted in LUCI are saved on the playout
system, must be Shared. LUCI will automatically send the
Template Description and Data Messages to this playout
folder.

CAMIO Device Manager

3. Enter the Playout Hostname in the Playout Hostname field. The Playout Hostname is the 
computer name of the playout device.

4. Select a drive letter, from the Playout Drive Mapping drop-down list box, to specify the 
drive mapping Lyric messages use to reference images on the playout device. Note that 
the drive mapping should equal the playout hostname and folder. 

An easy way of ensuring the drive mapping equals the playout
hostname and folder is to share the SCSII drive (typically the I drive).
This share then becomes the playout folder in these settings (e.g. a
Playout device named "Hyperx1" has a I drive shared as
"camioplayout"). The Playout Hostname and Playout folder
(\\hyperx1\camioplayout\) then equal the drive I on the local machine.
Alternately the playout folder can be mapped to an unused drive letter
on the playout machine. This new drive letter would then be selected in
the playout drive mapping dropdown.
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ADD/REMOVE PHYSICAL CHANNELS
You can add/remove physical channels as follows (Figure 42):

Figure 42  Physical Channels

To add a channel:

a. Enter a channel number in the Channel Number field.

b. Click Add.

To delete a channel: Click next to the channel you want to remove.

SETTING the SOCKET PORT NUMBER (click  to access this 
setting)
Locate the Socket Port field (Figure 43). The port number should be set to 10542. 

Figure 43  Socket Port

CREATING the DEVICE
1. Select Create Device from the drop-down list box next to the Submit button.

2. Click Submit.
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CAMIO CONTEXT MANAGEMENT 
OVERVIEW
A Context is a group of templates, images, and videos that are used on a show or group of shows. 
Contexts are created to organize these templates and assign specific playback hardware channels 
using the AdminTool Contexts menu.

Contexts are available from the drop-down menu in the templates and images tabs of LUCI. 
Contexts are generally created to separate different styles (i.e. different look news graphics - 
morning news and evening new looks), but can also be used to group content available to specific 
individuals such as weather and sport Contexts. 

The graphics and template messages in these Contexts can be
managed using CAMIO's Admin tools or the Asset Manager. Chyron
recommends that the management of Contexts be performed from the
Asset Manager once the Context has been created in the Admin Tools.

PRELIMINARY
1. Start the CAMIO Admin Tool utility. See “OPENING the CAMIO ADMIN TOOL UTILITY” 

on page 44.

2. Select Context from the left navigation panel (Figure 44).

Figure 44  Selecting Context
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3. The Context Manager (Figure 45) opens in the simple view. The simple view is sufficient 
for creating and editing Contexts, in most cases. However, in some instances it may be 
necessary to access the advanced view for more comprehensive configurations. To 
access and work with the advanced view, see “ADVANCED VIEW” on page 68.

NAMING the NEW CONTEXT
1. Select New Context from the Select Context drop-down list box. 

Figure 45  CAMIO Context Manager

2. Enter the name for the new Context in the Context Name field. The Context Name is used 
as a “Directory Namespace.” The Context Name must begin with a letter and may include 
underscore characters and a single dash but no spaces. When a new Context Name is 
entered, the Browser DSN field is automatically populated with a browser having the 
same name as the Context Name. This only occurs on initial data entry and can be 
changed to a different browser prior to submitting the new Context. 
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The Context Name may not be changed 
after being submitted. To change a Context to 
reference a different browser, the Context must be 
deleted and recreated with the new browser database. 

CREATE SQL DATABASE CHECKBOX
The Create SQL Database Checkbox (Figure 46) should always be checked. Doing this specifies 
that an SQL database should be created for the selected Context. 

Figure 46  Create SQL Database Checkbox

CURRENT MSG NUMBER COUNTER
The value of the Current Msg Number counter (Figure 47) is automatically initialized to 10000, but 
can be changed to start at some arbitrary value. 

Figure 47  Current Message Number Counter

Before changing this value, note that when the completed messages are sent to the output device, 
they are sent to a folder (of the same name as the Context) in the path set up using the Device 
Manager. If the type of composition is set to Template Data (see Context, advanced view), then 
the original Template Description Messages are sent to this folder on the output device, along with 
the created MOS Object (Template data) messages. Since the created message and template 
messages are sent to the same folder, it is recommended that the current message number be set 
to a value higher than any of the template message numbers, so that they are not overwritten by 
created MOS Object Messages.

Each time a new MOS Object is generated, it is automatically assigned
the value of the Current Msg Number + 1. This is automatically
reflected in the Current Msg Number field.

Important

The Current Msg Number is specified only on initial setup of
the Context. Once the initial setup is submitted, this number
can no longer be changed. This is done to prevent the
unintended overwrite of existing MOS Objects. 
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ASSIGNING VIRTUAL CHANNELS
Assigning channels enables the user to easily configure the output destination of the content 
created from this Context. Before any settings can be entered, however, devices must first be 
configured in the Device settings of Admin Tools. Once the device is configured: Select the 
channel association of the Lyric Message (this is done when the message is created in Lyric), then 
select an actual channel of a configured device, then select the actual device alias (as set up in the 
device settings). 

Before assigning a virtual channel, it is important to assign a wild-card (“*”) virtual channel. A wild-
card virtual channel is used when a message has no default channel assigned or the channel that 
has been assigned to a message is not configured in the Context Menu. A wild-card virtual 
channel will route these messages to the playout device and physical channel assigned to the 
wild-card virtual channel.

If no wild-card virtual channel is assigned, a warning message will be
displayed when the Context is submitted.

To assign a wild-card virtual channel (Figure 48):

a. Select the “*” virtual channel from the Virtual Channel drop-down list box.

b. Select the desired physical channel from the Physical Channel drop-down list box.

See “CAMIO DEVICE MANAGEMENT” on page 60, for detailed
information on setting up playout devices.

c. Select a playout device from the Device drop-down list box...

Figure 48  Assigning Channels

VIRTUAL
CHANNEL

PHYSICAL
CHANNELDEVICE
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d. Click on Add. Note that the Channel Assignments area displays these selections. 
Figure 49 shows how typical channel assignments might look.

Figure 49  Typical Channel Assignments

To assign a virtual channel (Figure 48):

a. Select a virtual channel from the Virtual Channel drop-down list box.

b. Select the desired physical channel from the Physical Channel drop-down list box.

c. Select a playout device from the Device drop-down list box.

d. Click on Add. Note that the Channel Assignments area displays these selections. 
Figure 49 shows how typical channel assignments might look.

To delete one or more channel assignments, refer to Figure 49 and perform the
following steps:

a. Click on remove next to each channel assignment to be deleted.

b. Select Update Context, from the Context drop-down list box.

c. Click on Submit, to update the Context. 

Changes are not made until they are submitted.

ENTERING a DESCRIPTION
Enter a description (optional) of this Context’s configuration and content in the Description field. 
See Figure 45.

CREATING the CONTEXT
1. Select Create Context from the Context drop-down list box (Figure 48).

The Context Name may not be changed after being submitted.

2. Click on Submit, to create a Context based on the settings you entered. 

WILD-CARD 
VIRTUAL CHANNEL

ASSIGNMENT
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ADVANCED VIEW

To display the Advanced View, click on , located to the right of the Select 
Context drop-down menu. The Advanced View is shown in Figure 50. The blue arrows indicate 
the Advanced View items. 

Figure 50  CAMIO Context Manager—Advanced View

NOTE 1: It is recommended that main volume path not be left on the “C” drive.

NOTE 2: Always select Lyric Data.
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The following table provides a description of Advanced View items.

ADVANCED VIEW ITEMS

Item Description

Enabled button Click this button to enable/disable this Context.

Context Name Enter the Context’s name.

Title Enter the Context’s title.

Main Volume Path 
field

Enter the local file system path to this Context’s repository in this 
field.This is the path where objects added to the Context (via Asset Man-
ager) are stored on the CAMIO server. This is usually set to 
c:\CAMIO\[context name], but can be changed by entering a new file 
path. 

NOTE: drive should be sufficiently large to store all the Template 
Description Messages and replacement images

Composition Type 
drop-down list box

Select the type of information contained in this Context from the following 
items provided in the drop-down list box: 

Lyric Data - Lyric Data Messages always reference, on playout, the orig-
inal Template Description Message from which they were created. 
When these assets are sent to the output device, the original Template 
Description Messages are also sent to the output device. Lyric Tem-
plate Data Messages generally have a much smaller file size and are 
therefore more efficient in the CAMIO file transfer process. Chyron highly 
recommends that Lyric Data Messages be used in CAMIO.

Lyric Composition - Lyric Composition files are completed Lyric graph-
ics with no reference to the original file from which they were created. 
They generally have a much larger file size than Lyric Data messages. 
Therefore, they are not recommended.

LyQuick Editor Styleric Macro - A Lyric Macro is a VB Script Macro that 
is saved as a *.lyr file. Refer to Lyric Online Help, for additional informa-
tion on using Macros in Lyric. 

Running Order field Not currently supported

Quick Editor Style This refers to the view of the Quick Editor in iSQ. The choices are 
either BASIC or ADVANCED.
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CAMIO USER MANAGEMENT
INTRODUCTION
User Administration specifies user access to the CAMIO server. Users can be created, updated 
and deleted. Users can be added to or removed from Groups and can be given access to specified 
Contexts.

PRELIMINARY
1. Start the CAMIO Admin Tool utility. See “OPENING the CAMIO ADMIN TOOL UTILITY” 

on page 44.

2. Select User from the left navigation panel (Figure 51). 

Figure 51  Selecting User
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3. The User Management page (Figure 52) opens in the New User default view. 

Figure 52  CAMIO User Management Page
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USER MANAGEMENT in CAMIO
One of the features in CAMIO is its ability to manage permissions from a central location using the 
Admin Tool. The fundamental concept of user management in CAMIO is that Users are assigned 
to Groups that are Trustees of Contexts. The following definitions should make this clear.

Contexts A Context is a group of templates and media that are used on a show or group of 
shows. Contexts are created and assigned specific playback hardware channels using the 
AdminTool>Contexts menu. 
Users CAMIO keeps a list of Users that require access to LUCI via the newsroom computer 
system. Users are created and assigned to Groups using AdminTool>Users. 
Groups Users can be assigned to one or more Groups using AdminTool>Users and 
AdminTool>Groups menus. Groups make it easier to manager access rights to large numbers 
of users.   
Trustees A Trustee is a Group that has access rights to a Context. Groups are assigned as 
Trustees using the AdminTool>Trustees menu. ("Read/Write Access" is the desired 
permission for any user that needs access to a Context.) 
Users are assigned to Groups that are Trustees of Contexts.

DEFINING and MANAGING GROUPS
Default Context Groups Some of the complexity of this hierarchy is masked from the 
administrator by an automatic process that takes place. Whenever a new Context is created, 
CAMIO creates a Group of the same name, and makes it a Trustee of that Context with full 
permissions. Users then have to be individually added to this Group. This is the most common way 
in which Groups/Trustees is used, but it is difficult to manage large groups of users and Contexts 
in this way. 

Creating Special Groups When managing large groups of users and many Contexts, it is useful 
to create special groups. For instance, the group MorningUsers can have access to a different set 
of Contexts than the group EveningUsers. The group SuperUsers can have access to everything. 
A group called AllUsers can be created that includes all users. 

This simplifies administration, because a new user only needs to be added to the SuperUsers 
group to have access to all Contexts. More importantly, if a new Context is created, the Group 
AllUsers can be made a Trustee rather than individually adding each user. 

Automatic User Entry The first time a user who is not registered in CAMIO logs in to LUCI:

•  the user’s username is automatically added to the list of users

•  the user is added to the All_Users group

This user will only have permissions to access contexts that have the group all_users assigned as 
a trustee. If this user is to have access to contexts that All_Users do not have access to, then he/
she will need to be added to additional groups that are trustees to the desired contexts.
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CREATING a NEW USER
To create a new user:

1. Be sure that New User is selected in the Select User field (Figure 53). 

2. Enter a user name in the User Name field. The user name should be the same as the 
iNEWS client login or ENPS computer login for the individual users. If a user has tried to 
access LUCI from their newsroom system and has received a "Please contact you system 
administrator for access to LUCI Contexts" message then their name should already exist 
in the User List. This user should have access to any context with the All_Users group as 
a trustee to the context.

Figure 53  Enter a User Name

3. Select a user type from the User Type dropdown list.

A new user type, Other, is now available. 
Using this type, the administrator can now change the 
ADMIN password, create new accounts, and provide the 
Chyron operators with accounts to use for uploading 
templates to Camio using the File>Save to Camio menu 
selection.

4. If you selected LUCI in the User Type field, skip to step 5. If you selected OTHER as a 
User Type, enter a password in the Password field and enter it again in the Confirm 
Password field. Proceed to step 5.

5. Enter descriptive information (optional) in the Description field about the user.

6. Select a group from the All Groups list box and add it to the Member of Group(s) list 
box. Groups are set in the Group Administration page.

7. If you selected LUCI as a User Type, skip to step 8. If you selected OTHER as a User 
Type, click Submit, to create a new user and complete this procedure.

8. Select a Context from the All Contexts list box and add it to the Playback Rights To list 
box. Contexts are set in the Context Administration page. From the Context(s) in this list 
box, the user can play back Template Data Messages in the Running Order tab from 
LUCI.Note that this feature is currently disabled. 
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9. You may now configure LUCI. See LUCI CONFIGURATION, below.

Be sure to click Submit, once your choices 
are made.

LUCI CONFIGURATION 
The LUCI Configuration (Figure 54) specifies which tabs/asset details in the LUCI ActiveX 
Interface in iNEWS or ENPS are visible and therefore accessible to the specified user. 

Figure 54  LUCI Configuration

There are five tab/information categories. Each one is described in the Categories table shown 
below.

CATEGORIES

Images Tab Shows the Image assets for the selected Con-
text. This must be set to Show, for image 
replacement to be available in LUCI.

Videos Tab Shows the Videos assets for the selected Con-
text.

XClyps Tab Shows the XClyps assets for the selected 
Context.

Running Orders Tab Shows the Running Orders.

Asset Details Shows Asset Details, including 2D Text and 
Object Template fields, for the selected asset.
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Three settings (selectable from each of the associated drop-down list boxes) are available for 
each of the above categories. Each one is described in the Settings table shown below. 

Make your selections based on the information provided above. Click on Submit after your 
choices have been made.

CREATING a DEFAULT USER NAMED CAMIO
A default user named CAMIO can be created from which the default settings for other users can 
be based. 

To create the user named CAMIO (See Figure 54 “LUCI Configuration” on page 74):

1. Enter the user name of CAMIO (all caps) in the Username field; select the desired 
settings for each of the categories (Images Tab, Videos Tab, XClyps Tab, Running 
Orders Tab, Asset Details). 

2. Select Create User, from the drop-down list box to the left of the Submit button.

3. Click on Submit, to create a user based on the specified settings. This choice is available 
only when New User is selected in the Select User drop-down list box.

SETTINGS

Default The user is shown the tab/asset details, as set for 
the default user named CAMIO, that is set in this 
page.

Show The tab/asset details are displayed and accessi-
ble to the user.

Hide The tab/asset details are hidden and inaccessible 
to the user.
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CAMIO GROUP MANAGEMENT
WORKING with GROUPS
INTRODUCTION
One of the features of CAMIO is the ability to manage user permissions from a central location 
using the Admin Tool. The fundamental concept of user management in CAMIO is that users are 
assigned to Groups that are Trustees of Contexts. The Admin Tools Group menu lets you create, 
update, and delete Groups.

1. Open the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 
page 44.

2. Select Group from the left navigation panel (Figure 55).

Figure 55  Selecting Group

3. The Group Management page opens (Figure 56).

Figure 56  Camio Group Management Page
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CREATING GROUPS
Group Administration sets up Groups and permissions for users within those Groups. Groups can 
be created, updated and deleted. Users can be added to or removed from Groups. The following 
table describes the functionality provided by the Group Administration page:

ITEM DESCRIPTION

Select 
Group

Selects desired Group for edit, or initializes the fields when New Group is 
selected.

Group Name Specifies the name of the Group.

Description Descriptive information about the Group (optional).

All Users Lists all recognized users within the directory /CAMIO/Users. Users are set in 
the User Administration page.

Users in 
Group

Lists the users that are members of the currently selected Group or, after edit-
ing, the users that will be members when the record is updated.

>> Button Adds the selected user(s) from the All Users list to the Users in Group list.

<< Button Removes the selected user(s) from the Users in Group list. 

Submit Executes action selected in the drop-down list box to the left of the Submit button. 
Actions include: 

•  Update Group: Saves any changes made to the 
Group's record.

•  Delete Group: Removes the selected Group from the 
directory.

•  Create Group: Creates a Group based on the 
specified settings. This choice is available only when 
New Group is selected in the Select Group drop-down 
list box at the top of the Group Administration page.
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CAMIO TRUSTEE MANAGEMENT
INTRODUCTION
A Trustee is a Group that has access rights to a Context. Groups are assigned as Trustees using 
the Trustee Administration page. 

1. Open the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 
page 44.

2. Select Trustee from the left navigation panel.

Figure 57  Selecting Trustee Management

The Trustee Management page opens (Figure 58).

Figure 58  Camio Trustee Management Page
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ADDING a TRUSTEE
Adds the selected Group to the list of Trustees. 

To add a new Group as Trustee to a Context:

1. Select a group from the drop-down list box.

2. Click Add Trustee.

DELETING a TRUSTEE
The following procedure deletes the selected Trustee.

To delete a Trustee:

1. Select a Trustee to delete from the drop-down list box, as shown below in Figure 59.

Figure 59  Remove Trustee

2. Click Remove Trustee.
79



CAMIO SCRIPT MANAGEMENT
WORKING with SCRIPTS
INTRODUCTION
The Admin Tool Scripts menu lets you control the CAMIO scripts. 

1. Open the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 
page 44.

2. Select Scripts from the left navigation panel. 

Figure 60  Selecting Scripts
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The Script Management page opens (Figure 61).

Figure 61  Camio Script Management Page

CAMIO Scripts are automated processes that run on a regular basis to perform housekeeping 
functions on the CAMIO server. Since the scripts temporarily disable CAMIO functionality, they 
should be run at a convenient time when it will not interfere with news operations—for example, 
between midnight and 3 A.M., but can be varied, to fit the station's schedule.
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To select a script, click on the Select Script (Figure 62) drop-down list box. 

Figure 62  Select Scripts List Box

The following scripts are available:

Shutdown—Automatically restarts the CAMIO service. It does not restart the OS. By default it 
is run at 3 am every day.

Log Purge—This script deletes log files n days old. By default it is run at 2 A.M. every day and 
removes log files older than 3 days old.

Directory Backup—This script creates a backup of the CAMIO virtual directory structure. 
These backups can be used to restore the configuration and users of a CAMIO server. By 
default, it is run at 1:30 A.M. every day. 

Cache Contract—This script moves all but the most recent 'MaxSize' items from the primary 
MOS object cache to the secondary cache. MaxSize specifies the number of items to keep in 
the primary cache. If MaxSize is zero (0), then all objects are moved out of the primary cache. 
By default it runs at Midnight every Sunday with a MaxSize value of 2000. Chyron 
recommends that MaxSize be set to 100 and that the Cache Contract run nightly.

Cache Rollover—This script must be manually run. It deletes all cache objects from a 
specified Context and resets the message number. 

RUNNING the SCRIPTS
To adjust the time the script is run, enter the time in the appropriate fields and click on Submit to 
update the script.

Examples:

Shut Down Script

1. Select Shut Down from the Select Script drop-down list box.

2. Enter the following default settings:

This script is now set to run at 3 A.M. of every day.

Minute 0 Month of Year *

Hour 3 Day of Week *

Day of Month *

Note: “*” means ‘every’, as in every day, every month, etc.
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Cache Contract Script

1. Select Cache Contract from the Select Script drop-down list box.

2. Enter the following default settings for the Cache Contract script: 

This script will run at Midnight on Sunday.

To run a script immediately, select Run Script Now. Click Submit.

OVERVIEW—MOS OBJECT CACHING in CAMIO
MOS Objects (Lyric messages) are created by LUCI in the NCS client. The MOS object is a very 
small Template Data Message and some associated XML data and thumbnails. The MOS object 
is saved in the primary cache, a data file on the CAMIO server. The Template Data Message is 
also immediately sent to the playback machine, along with any necessary images, videos, or 
Template Description Messages. As long as the MOS object lives in primary cache, the CAMIO 
system will monitor the playback machine and re-send the file in case it is deleted. If the playback 
machine is changed in CAMIO administrator, CAMIO will send a copy of the Template Data 
Message to the new machine.   

The constant monitoring of the primary cache described above uses a lot of resources if the cache 
gets too large. Therefore, there is a process called "Cache Contract.” Cache contract can be 
programmed to run on a regular basis and at a convenient time of day. It removes unused MOS 
objects from the primary cache and puts them into secondary cache. At the same time, it also 
deletes the associated Template Data Messages from the playback machine.   

MOS Objects will remain in secondary cache unless manually deleted. There is no fixed policy on 
when to purge objects from the secondary cache. The size of secondary cache is limited only by 
the storage space on the CAMIO server. MOS objects can be re-used as long as they are still in 
secondary cache. If the NCS requests an old MOS object that was moved to secondary cache, it 
is moved back into the primary cache and re-loaded on the playout machine.

If using the cache, rollover script objects will not always be available.
Each time the script is run all old objects will be overwritten by new
objects. It is recommended that this script be disabled.

Minute 0

Hour 0

Day of Month *

Month of Year *

Day of Week 0

Note: “*” means ‘every’, as in 
every day, every month, etc.
0 = Sunday
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LOG VIEWER
WORKING with the LOG VIEWER
INTRODUCTION
The Log Viewer lets you view the logs generated by CAMIO. These logs record information that is 
useful for trouble shooting problems. If you have any problems you may be asked by your Chyron 
Customer Service technician to use this page to view a log.   

1. Open the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 
page 44.

2. Select Log Viewer from the left navigation panel (Figure 63). 

Figure 63  Selecting Log Viewer

3. The Log Viewer page opens (Figure 64).

Figure 64  Log Viewer Page
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FORMAT
All Log files are stored in the CAMIO/log directory in text files with names in the format:

year.month.day.hour.min.sec.log

For instance, 05.10.15.11.18.12.log was first generated on 11:18:12, October 15th, 2005. All log 
events in the file are time stamped in a similar format. 

BACKING UP YOUR LOGS 
If you experience an unusual problem, it is often useful to backup your log files as soon as 
possible and zipping them up so that they can be e-mailed to Chyron for analysis. To do that, do 
the following procedure:

1. Select the c:/program files/Chyron/camio/log folder.

2. Right-click and send to Compressed (zipped) folder. This will create a file called c:/
program files/Chyron/camio/log.zip.
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MIME TYPE MANAGEMENT
WORKING with MIME TYPE MANAGEMENT
INTRODUCTION
Mime Type specifies to the CAMIO server how to interpret data that it processes. 

1. Open the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 
page 44.

2. Select Mime Type from the left navigation panel (Figure 65). 

Figure 65  Selecting Mime

3. The Mime Type page opens (Figure 66, page 87). The table on page 88 describes the 
functionality provided by the Mime Type Management page.

Refer to “APPENDIX G: MIME TYPES” on page 150 for a listing of 
Mime types.
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Figure 66  Mime Type Management Page
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MIME TYPE MANAGEMENT PAGE

Parameter/Setting/
Function

Description

Select Mime Type 
Listbox

Specifies the Mime Type content string that is returned when the files 
with the specified extensions are returned to the user through the http 
device. The following shows a list of Mime types that might be found 
on a CAMIO server.

Name field Specifies the name of the Mime type.

Mime Type field Specifies the Mime type string as Type/sub-type.

Description Enter descriptive information regarding the Mime type in this field 
(optional).

Map Extension An extension(s) can be mapped to a Mime Type. For example, the 
JPEG Mime type can include both .jpeg and .jpg extensions.

Unmap Extension Used to delete a mapping from the Mime type:
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HOTSYNC FOLDER MANAGEMENT
WORKING with HOTSYNC FOLDER MANAGEMENT
INTRODUCTION
The user can define one or more Hot Sync folders. Each folder can deliver assets to a chosen 
context subfolder along with a chosen metadata mapping. 

1. Open the CAMIO Admin Tool. See “OPENING the CAMIO ADMIN TOOL UTILITY” on 
page 44.

2. Select HotSync from the left navigation panel (Figure 67). 

Figure 67  Selecting HotSync

3. The HotSync Folder Management page opens (Figure 68).

Figure 68  HotSync Folder Management Page
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To create a Hot Sync folder:

1. In the Name field, enter a descriptive name for the hot sync folder.

2. In the Path field, enter the absolute pathname or UNC pathname.

3. Enter a file pattern in the File Pattern field. This pattern specifies the file mask which 
determines which files to process. For example, c:\CAMIO\Hot Sync Images\*.jpg will 
only process jpg files. Note that *.* will accept all files.

4. Select the context you want the asset delivered to from the Context drop-down list.

5. In the Context Path field, specify an absolute path to where in the Context processed files 
will be stored. For example, / is the root and /Images is the Images folder directly under 
the root.

6. The value (in milliseconds) in the Scan Interval field determines how often Camio will 
check the HotSync folder for new assets. The default value should only be changed by 
knowledgeable users.

7. Select a replacement rule from the Replacement Rule drop-down list. The available 
choices are defined below:

•  Create Unique Record—renames asset file with UUID to prevent 
overwriting a file if a file with the same name is uploaded via the same 
hotsync.

•  Create and Update—maintains original filename and will allow 
overwriting (updating) if a file with the same name is uploaded via the 
same hotsync.

•  Update Only— same as Create and Update, except that an image 
name that does not match an image already in the folder is not 
ingested

•  Create and No Update—same as Create and Update, except that 
an image name that matches an image already in the folder is not 
ingested.

•  Create and Update with given UUID—same as Create and 
Update, except that the asset’s filename is used as the UUID (this 
should be used only when an XML sidecar will be delivered with the 
asset, as in WAPSTR, AXIS, or OMS appliocations.

8. Select which metadata mapping you want to use from the Metadata Mapping drop-down 
list.

9. Click Submit.
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CHAPTER 7 CAMIO ASSET MANAGER

OVERVIEW
The Asset Manager is a powerful tool in CAMIO for managing graphics and Lyric templates (also 
referred to as assets). It can be used as part of the MOS newsroom system for managing MOS 
assets or for management and distribution of assets independent of a MOS newsroom system. 

The Asset Manager allows users to browse and manage graphics both locally and remotely on
CAMIO connected systems. Assets can be viewed, sorted, edited, copied, deleted, and
downloaded. A virtual folder hierarchy enables simple, yet sophisticated organization.

TWO VERSIONS
Two versions of Camio Asset Manager are currently supported. The latest version is described in 
this chapter. The prior version is described in “APPENDIX F: CAMIO ASSET MANAGER (legacy)” 
on page 134. This is the last version of Camio to support legacy versions of Asset Manager. 

NEW ASSET MANAGER ADDITIONAL FEATURES
•  requires no JAVA Permissions to download assets

•  supports the new replication function

•  supports Mac using Safari and Firefox browsers

•  supports PC using Safari, Firefox, and Internet Explorer browsers

GETTING STARTED
If you have not already done so, install the new Asset Manager. See “INSTALLING the NEW 
ASSET MANAGER” on page 19.

CONNECTING to a LOCAL HOST (from the CAMIO server)

The Service Broker must be running to 
access the Asset Manager.

1. Open a Web browser.

2. Enter the following URL: http://localhost:8080/assetmanager (8080 is the data 
connection port used by CAMIO), or click on Start>All 
Programs>Chyron>Camio>Asset Manager.
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3. Click Enter or Go. To Open the Login Window click on Open System; the Login window is 
displayed (Figure 69).

Figure 69  CAMIO Asset Manager Login Window

4. Enter the CAMIO server name (or localhost if opening Asset Manager from the CAMIO 
server), a user name, and password.

5. Click OK. The Asset Manager is displayed, See Figure 71 on page 94.

CONNECTING to a REMOTE HOST (from a remote computer)
The Asset Manager can be accessed using a URL that contains either the System Name or IP 
Address, as shown below:

http://<servername>:8080/assetmanager

or 

http://<IP address>:8080/assetmanager

For example, the following URLs for the server CAMIO-R1 with an IP Address of 10.10.2.204 
would be valid:

http://camio-r1:8080/assetmanager

http://10.10.2.204:8080/assetmanager.html

To connect to a remote host:

1. Enter a URL as described above. 

2. Click Enter or Go. The Login window is displayed (Figure 69).
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Figure 70  Login Window

3. Enter a user name and password.

4. Click Sign In!. The Asset Manager is displayed (Figure 71).

Figure 71  CAMIO Asset Manager
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ASSET MANAGER INTERFACE
The Asset Manager Interface (Figure 72) consists of a Server/Context window, an Asset Display 
window, and an area where files may be dropped and entered into Asset Manager.

Figure 72  ASSET MANAGER INTERFACE

Server/Context Window (Figure 73) - displays the various servers on the system, Context icons, 
and any Context sub-folders. 

Figure 73  Server/Context Window

A plus sign to the left of the Context icon indicates that there are sub-folders in that Context. 
Clicking on the plus sign will expand the view and allow you to browse the sub-folders. 

Using Context sub-folders provides a convenient way to organize different types of assets within a 
Context. The recommended folder hierarchy, shown below, matches the Lyric browser hierarchy.

•  messages

•  images

•  XClyps

•  videos

SERVER/CONTEXT
ASSET DISPLAY WINDOWWINDOW

DROP NEW FILES HERE
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Asset Display Window (Figure 74) - displays Context assets. Note that assets with Alpha 
channels display a checkerboard background.

Figure 74  Asset Display Window

Right-clicking on the Asset Display Window displays a context menu (Figure 75) whose menu 
items you can use to:

•  change icon size

•  switch to thumbnail view

•  refresh display

•  set which columns are displayed 

Figure 75  Asset Display Window—Context Menu
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Refresh Display, Change Icon Size, Switch to Thumbnail View

To refresh the display or change icon size or switch to the thumbnail view, simply select the 
desired menu item. 

Selecting Show Small Icons from the context menu changes the display to appear as shown in 
Figure 76).

Figure 76  Small Icons

Selecting Show Large Icons from the context menu changes the display to appear as shown in 
Figure 77 ).

Figure 77  Large Icons
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Selecting Show Thumbnail View from the context menu changes the display to appear as shown 
in Figure 78).

Figure 78  Thumbnail View

Set Columns

To set which columns (metadata fields) are displayed, select Set Columns from the context 
menu. The Show Metadata Fields dialog (Figure 79) is displayed.

Figure 79  Show Metadata Fields Dialog

To add one or more fields, select the desired field(s) from the window on the left and click Add. To 
remove one or more fields, select the desired field(s) to remove from the window on the right, and 
then click Remove.
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WORKING in ASSET MANAGER
ENTERING FILES
In the following procedures, you will be uploading files to Asset Manager.

ENTERING FILES ONE at a TIME
To enter a file:

1. Any file type can be entered in Asset Manager. Simply drag and drop the file onto the 
indicated area (Figure 80). 

Figure 80  Entering Assets

2. After dropping the new file in the indicated area, the New Asset Details dialog (Figure 81) 
is displayed. Use this dialog to enter meaningful metadata about the asset in the Subject, 
Keywords, and Comments fields. 

Important

It is important that meaningful metadata is entered to facilitate
searching the asset database at a later time. Asset Manager has a
search tool that allows you to search for files using this metadata. The
metadata is also used by the newsroom to conduct searches in LUCI.

Figure 81  New Asset Details Dialog

DROP NEW FILES HERE
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3. When done entering metadata, click Upload. The new file is then uploaded to the Asset 
Manager, and a thumbnail image of the file is displayed in the Asset Display window, along 
with the accompanying metadata.

ENTERING MORE THAN ONE FILE at a TIME
To enter files:

1. Use Ctrl + click to select multiple files and drag and drop them onto the indicated area in 
Asset Manager. The New Asset Details dialog (Figure 82) is displayed. 

Figure 82  New Asset Details—Use as Template For All Files

2. Enter meaningful metadata about the files in the Subject, Keywords, and Comments 
fields.

See “ASSET FORMATTING” on page 57 for a listing of format strings
you can use.

3. Check the Use As Template For All Files checkbox (applies the metadata you enter to all 
selected files), or leave it unchecked (allows you to enter metadata separately for each of 
the selected files). 

4. Click on Upload.

5. If you checked Use As Template For All Files, click Upload and skip to step 8. 
Otherwise, proceed to step 6.

6.  When done entering metadata for the first selected file, click on Upload. 
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7. Enter metadata for the next selected file. Click on Upload. Repeat step 6 and step 7 until 
all the files have been uploaded. Then, proceed to step 8.

8. All the files will be uploaded to the Asset Manager with the metadata you just entered. A 
thumbnail image of each of the uploaded files is displayed in the Asset Display window.

STORING IMAGE FILES and LYRIC TEMPLATES
Asset Manager handles the storing of image files and Lyric templates as follows:

Image Files
An image file will generate a thumbnail image when entered into Asset Manager. These 
thumbnail images will also be displayed in LUCI’s Image Browser when the applicable Context 
is selected.

Lyric Templates
To use Lyric templates in LUCI, they must have been previously saved with XML. See Saving 
Lyric Templates with XML, below. Asset Manager will report an error in the Status Window, if 
you try to store a .lyr file that does not have XML in it.

SAVING LYRIC TEMPLATES with XML
In order to enter Lyric templates into Asset Manager, they must have been previously saved with 
XML. To do this, save the template in Lyric. Lyric must be running on a template creation 
workstation that has the XML and MOS plug-ins installed and configured correctly. See 
“INSTALLING the NEW ASSET MANAGER” on page 19. The template creation workstation can 
be an offline Lyric system or a Lyric-based system. The template creation workstation should not 
be on the CAMIO server. 

The template creation workstation can be an offline Lyric system or a 
Lyric-based system. The template creation workstation should not be 
on the CAMIO server. 

CONTEXTS
Clicking on a Context icon will display all the assets in the Asset Display window. A plus sign to the 
left of the Context icon (Figure 83) indicates that there are sub-folders in that Context. Clicking on 
the plus sign will expand the view and allow you to browse the sub-folders. 

Figure 83  Click to View Subfolders

CLICK TO
EXPAND
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CONTEXT SUBFOLDERS
Using Context subfolders offers a convenient way to organize different types of assets within a 
Context. It is recommended to create and name folders that match the content that will be 
uploaded.

Adding a New Folder

To add a new folder:

1. Right-click on the Context. 

2. Select New Folder from the context menu that appears. The Create Folder dialog 
appears (Figure 84). 

Figure 84  Create Folder

3. Enter the name of the new folder. 

4. Click OK.

To use Lyric templates in LUCI, they must have been previously saved with XML. Asset Manager 
will report an error in the Status window if you try to store a .lyr file that does not have XML in it.

DELETING OBJECTS
To delete an object from a Context, right-click on the object and select Delete. The object will then 
be moved into the Trash bin and may be deleted from there. To delete the contents of the Trash 
bin, right-click on the Trash bin and select Empty Trash.

To delete an object without moving it to the Trash bin, hold down the Shift key, while performing 
the delete operation. This operation cannot be undone.
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VIEWING/EDITING OBJECT PROPERTIES
Object properties can be edited once an object has been uploaded by right clicking on the object 
and selecting Properties. The Properties dialog appears with the General tab selected by 
default. See Figure 85. The Properties dialog allows edits to be made to the metadata as well as 
offering the ability to change Virtual channel assignments and snap frames. See below for detailed 
descriptions of these tabs. 

General Tab (Figure 85) - The General tab displays the Lyric message number, type of file, 
Lyric build number, and other pertinent file information including if files were saved with XML 
(see Attributes).

Figure 85  Properties—General Tab
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Summary Tab (Figure 86) - The Summary tab provides Title, Subject, Author, Keywords, 
and Description fields that may be edited.

Figure 86  Properties Dialog—Summary Tab

MOS Tab (Figure 87) - The MOS tab provides various fields for editing.

Figure 87  Properties Dialog—MOS Tab
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UPLOADING REPLACEMENTS
When an object is uploaded to the CAMIO server using Asset Manager, it is automatically 
assigned a GUID (Globally Unique ID). If an object is deleted, the GUID is also deleted. 

Replacing an Existing Object

If an existing object needs to be replaced, it is best practice to upload a replacement by right 
clicking on the object and selecting Upload Replacement from the context menu (Figure 88).

Figure 88  Upload Replacement

The following example should make this clear.

Example: A new lower third has been created to replace the current lower third. All new and 
existing LUCI objects should use this new message. You should select Upload Replacement, 
rather than Delete. If you delete the old object, then any LUCI objects created from that object 
will still play out with the old content. Only if Upload Replacement is used will all LUCI objects 
reflect the change. 

Important

If an object is deleted from the Asset Manager, the
newsroom should refresh their LUCI browser to ensure that
their LUCI browser is not offering any objects that are no
longer available. If an image has been deleted from a Context
using Asset Manager and LUCI has not been refreshed, it is
possible for the newsroom to preview a graphic correctly
even if the image no longer exists.
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To Replace an Existing Object:

1. Right-click on the object to be replaced.

2. Select Upload Replacement from the context menu (Figure 88). A Drop Replacement 
File Here window (Figure 89) appears.

Figure 89  Drop replacement File Here

3. Drag and drop the replacement file onto this window.
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CHANGING VIRTUAL ASSIGNMENTS
To do this:

1. Select a Template.

2. Right click and select the MOS tab from the properties page.

3. Edit the Channel text box.

CHANGING SNAP FRAME
To do this:

1. Select a Template.

2. Right click and select the MOS tab from the properties page.

3. Select new Snap Frame.
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APPENDIX A: INSTALLING CAMIO SOFTWARE 
UPDATES

INTRODUCTION
On occasion, Chyron will release software updates for the CAMIO software and/or the Lyric 
software used in the CAMIO MOS System. 

Since the CAMIO MOS System will not be operational during the updates, it is important to 
prepare properly: 

•  Budget the proper amount of time for the update.

•  Back up all files being updated. 

•  You must have physical access to all the computers affected by the 
upgrade.

•  You must have administrative rights to all the computers.

•  Have your license keys handy. Check to see if a new license code or 
dongle is required. 

•  Check the interoperability of the new software with other components in the 
system (i.e. CAMIO version with Lyric and LUCI versions).

You may get the CAMIO and/or Lyric 
software updates as an Installation CD or as a 
downloaded file. 

CAMIO 
Prior to installing new software, stop the CAMIO Service.

To do this, you may do either of the following:

1. In Windows, click on Start > Run. 

2. Enter net stop CAMIO in the dialog that appears.

3. Click on OK.

or

1. In the Windows Control Panel, double-click on Administrative Tools. The 
Administrative Tools window opens.

2. Double-click on Services. The Services window opens. 
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3. Right-click on CAMIO in the list of services. Select Stop from the context menu.

To install the software:

1. Make a backup of the CAMIO directory, in case there are any problems with the 
installation.

a. Use Windows explorer to locate the C:\Program Files\Chyron\Camio folder.

b. Right-click on the folder and select Copy from the context menu. 

c. Right-click in the right explorer pane and select Paste from the context menu. A 
folder called "Copy of CAMIO" will be created. Save this folder until you verify the new 
installation.

2. Run the installation program. On the first pass select Remove from the Modify, Repair, 
Remove dialog box and click "Yes, I want to remove all CAMIO components." 

3. Re-run the installation program, entering the CAMIO system username and password. It 
will not be necessary to re-enter a license key.

4. Re-start the CAMIO Service.

To do this, you may do either of the following:

a. In Windows, click on Start > Run. 

b. Enter net start CAMIO in the dialog that appears.

c. Click on OK. 

or

a. In the Windows Control Panel, double-click on Administrative Tools. The 
Administrative Tools window opens.

b. Double-click on Services. The Services window opens. 

c. Right-click on CAMIO in the list of services. Select Start from the context menu.

Often, when a new version of camio is 
being installed, Chyron will recommend a specific 
version of Lyric for use with the new version of CAMIO. 
Refer to “INSTALLING LYRIC and ASSOCIATED 
TASKS” on page 10.

MOS XML PLUG-IN
CAMIO software updates usually include new versions of the MOS XML plug-in used in Lyric on 
the CAMIO server, the Graphics Preparation Workstation, and the Lyric-based Playback 
machines. For details on installing the XML plugin, refer to “INSTALLING the LYRIC MOS XML 
PLUG-IN” on page 16.
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LUCI MOS ActiveX 
CAMIO Software updates usually include a new version of the LUCI MOS ActiveX Control. Since 
there are usually many Newsroom Client Workstations, updating LUCI can be a big task. Find out 
if the new CAMIO software is compatible with your current version of LUCI, so you can gradually 
upgrade the Newsroom Clients rather than doing them all at once. 

INSTALLING LUCI
LUCI software can be installed locally at each workstation, or can be installed remotely using 
Active Directory or PsExec. 

BEFORE INSTALLING LUCI
Depending on the security levels of your internet browser, you may need to add the CAMIO server 
as a trusted site in the Internet settings of your browser. To do this:

1. From the Internet Browser menu, select Tools>Internet Options. The Internet Options 
dialog box opens.

2. Select the Security tab. Click on Trusted sites.

3. Click on Sites. The Trusted Sites dialog box is displayed.

4. Enter the following URL: http://<CAMIO_SERVER>.

5. Uncheck the Require sever verification (https) for all sites in this zone checkbox.

6. Click Add.

7. Close the Trusted sites and Internet Options dialogs.

REMOTE INSTALLATION

1. Log on to the Newsroom client workstation with an administrative account.

2. Go to Installer Web Page http://camioserver:8080/install.tsp (where camioserver is the 
network name of your CAMIO server).

3. Click on LUCI (Chymox ActiveX).

4. Click on RUN on the next two dialog boxes to start Install Shield Wizard.

5. Select Remove from the "Modify, Repair, Remove" dialog box to remove the old version of 
LUCI. 

6. Select No, do not restart computer, when prompted.

7. Repeat installation steps 3 and 4.

8. Enter your CAMIO server hostname when prompted, and click on Install.

LOCAL INSTALLATION

1. Log on to the CAMIO server with the CAMIO Account.



2. Go to Installer Web Page http://localhost:8080/install.tsp.

3. Click on Active Directory or PsExec, and follow the instructions for installing LUCI 
remotely using. 

LYRIC UPDATES
Lyric software updates can be installed independently of CAMIO software updates. The same 
version of Lyric should be used on the CAMIO server, the Graphics Preparation Workstation, and 
the Lyric-based Playout machines. There are some exceptions. Call Chyron Customer Service if 
you have any questions. 

Note which directory the new Lyric will install into. By default Lyric usually installs in a directory 
labeled with the version number. That may or not be the same directory used by the existing 
version of Lyric.

INSTALLING into the SAME DIRECTORY
•  Make a backup copy of the existing Lyric directory as a precaution.

•  Install Lyric. See “INSTALLING LYRIC and ASSOCIATED TASKS” on 
page 10.

•  After verifying the new installation, delete the backup copy. 

INSTALLING into a DIFFERENT DIRECTORY
•  Install Lyric. See “INSTALLING LYRIC and ASSOCIATED TASKS” on 

page 10.

•  Run the new version. It will ask for your license key. On the CAMIO server, 
this is the same license key used by the CAMIO software. 

•  Re-install the MOS XML plug-in, using Install.tsp link to the CAMIO server. 
Make sure you install into the correct directory.

•  Check the configuration of the MOS XML plug-in, and correct if necessary.

•  On the CAMIO server, re-register this new version of Lyric, using the Lyric 
server Configuration Utility.



APPENDIX B: INSTALLING and CONFIGURING 
CAMIO SERVER SOFTWARE

INTRODUCTION
CAMIO server Software has already been installed at the factory. This section servers as a guide, 
in case the software needs to be re-installed.

INSTALLING CAMIO SERVER
GETTING STARTED

Important

Your system must be running Windows Server 2003, Web
Edition, to successfully install and run CAMIO server.

1. Configure your network settings.

2. Create a new user in Windows on the CAMIO server computer that has a password and is 
an administrator that can log on as service. After doing this, check User Rights 
Assignment by selecting Control Panel>Administrative Tools>Local Security Policy. 
Select Local Policies then User Rights Assignments then Log on as Service. Your user 
should have Local Policy settings.

INTRODUCTION
The CAMIO server can be installed as either a User Application or as a System Service. It is
recommended that CAMIO server be installed as a System Service, because it automatically
launches when Windows launches, and does not require that a user be logged on the system. If
CAMIO server is installed as a User Application, CAMIO server must be either started manually
from a logged-on user session or programmed as part of startup when a user logs on. 

When CAMIO server is installed as a 
System Service, it also includes the ability to run as a 
User Application.

Instructions for both types of installations, System Service and User Application, are included in 
the following procedure.
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INSTALLING the CAMIO SERVER
To install the CAMIO server:

1. Insert the CAMIO Installation CD into a CD drive. The CAMIO server 2 Installation Utility 
page should open. If it does open, proceed to step 2. If it does not open, see Installation 
Utility Page Does Not Open, below.

2. Click the Install link below the CAMIO logo. 

3. The InstallShield® Wizard starts. Proceed to “CAMIO SETUP” on page 114.   

Installation Utility Page Does Not Open
a.  From the Windows Start menu, select Run. The Run dialog appears.

b. Type “<CD Drive Name>:\CAMIO\CAMIO_<version>.exe” in the Open field, where 
<CD Drive Name> is the drive letter assigned to the drive in which the CAMIO 
Installation CD is inserted, and <version> is the version of the software. For example, if 
the drive letter is “D”, and the version is 2.0, the string would be typed as 
D:\CAMIO\CAMIO_2_0.exe.

c. Press OK. The InstallShield® Wizard starts (Figure 90). Proceed to “CAMIO SETUP” on 
page 114.

Figure 90  CAMIO Install Wizard Startup
113



CAMIO SETUP
1. The CAMIO Setup Welcome screen (Figure 91) is displayed. From this point forward, a 

sequence of dialog boxes guides the installation. Click Next.

Figure 91  CAMIO Setup Welcome Screen

2. The CAMIO License Agreement (Figure 92) is displayed. Click Yes to accept the terms of 
the license agreement. 

Figure 92  CAMIO License Agreement
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3. The User Information dialog (Figure 93) is displayed. Enter your name and your 
companies name, then click Next.

Figure 93  CAMIO User Information Screen

4. The Choose Destination dialog box (Figure 94) is displayed. Click Next to accept the 
default destination, or browse to select a new destination. The Setup Type dialog box 
(Figure 95) is displayed. 

Figure 94  Choose Destination
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Figure 95  Setup Type

5. Select the setup type to install:

• Typical Program is installed with the most common options, and automatically 
installs CAMIO as a Service. If Typical is selected, skip to step 6 on page 117.

• Compact Program is installed with minimum required options, and automatically 
installs CAMIO as a Service, minus Media Codecs, which saves disk space. If 
Compact is selected, skip to step 6 on page 117.

• Custom Custom allows for installation of additional components and for installation 
of CAMIO as a System Service or as an Application. If Custom is selected, the Select 
Components dialog box (Figure 96) opens.
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Figure 96  Select Components - Custom Installation Only

The following components can be selected:

• Program Files - This component includes all runable binary executables and Web 
administration files. Program Files cannot be deselected.

• Help Files - This component includes all Web-based Help documentation.

• Media Codecs - These are Media Codecs required by the Asset Manager.

• ServiceBroker Service - The Service Broker is installed and registered as a System 
Service. CAMIO must then be opened and closed from the System Service window. 
This setting specifies that CAMIO is the specified user when it is launched. Note that if 
specifying a Windows Domain account, the username must be preceded by the 
domain name. For example, if the Windows Domain name is NEWSDOMAIN and the 
user account name is CamioService, then “NEWSDOMAIN\CamioService” must be 
entered in to the Username field. This is not required if the user account is not for a 
Windows Domain.

6. Click Next. The Select Program Folder dialog (Figure 97) opens.
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Figure 97  Select Program Folder

7. Select either the default folder or a different folder in which to install CAMIO, then click 
Next. CAMIO needs approximately 1 GB of disk space to run. If a Disk Space Prompt is 
displayed, it is recommended that an alternative drive be selected. Click Yes to change 
drive or No to install on the selected drive. Note that if CAMIO is installed on a disk that 
has less than the recommended available capacity, performance may be compromised.

8. The Edit Data dialog box (Figure 98) is displayed.

Figure 98  Edit Data Dialog Box
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9. Enter the user account that the ServiceBroker will run in the User field.

10. Enter the password in the Password field. If specifying a Windows Domain account, 
then the Username must be preceded by the domain name. For example, if the Windows 
Domain name is NEWSDOMAIN and the user account name is CamioService, then 
NEWSDOMAIN\CamioService must be entered in to the User field. This is not required if 
the user account is not for a Windows Domain. If an error message is displayed stating 
that the registration failed, then the ServiceBroker Service should be registered from a 
command prompt. To do this: 

•  Click Start > Run, and then execute cmd.exe. 

•  Change directory (cd command) to the CAMIO Installation Directory, and 
then execute Servicebroker.exe –service –user <USERNAME> –pw 
<PASSWORD>, where <USERNAME> is the user account name and 
<PASSWORD> is the password associated with the specified user 
account.

-pw <PASSWORD> can be left out if the specified account has a blank
password.

11. If a Couldn’t create service message is displayed, make sure that the user has the right 
to log on as a service. For information on granting this right, refer to Granting a User or 
Group the Right to “Log on as a service” in the section on Running CAMIO Server.

12. The Start Copying Files dialog box (Figure 99) is displayed.

Figure 99  Start Copying Files Dialog
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13. Review the setup settings. If they need modification, click Back to navigate back to the 
earlier dialog boxes to make the changes. If the settings are satisfactory, click Next. 
Installation starts and progress is displayed.

During the installation, a dialog box may be displayed asking
permission to overwrite the files setup.exe and setup.ini. Click Yes for
each of these files.

14. When installation is complete, the Setup Complete dialog box (Figure 100) is displayed. 
Note that the Start ServiceBroker now? checkbox does not appear if installing as only a 
User Application or if modifying a previously installed version as a System Service. If the 
checkbox does not appear, skip to step 15.

•  If the specified user has been granted the right to “Log on as a service” in 
the Local Security Policy, check the Start ServiceBroker now? checkbox, 
to start the Service Broker immediately following the completion of the 
installation, or leave the checkbox deselected (unchecked) to start the 
Service Broker at a later time.

•  Leave the Start ServiceBroker now? checkbox deselected (unchecked) if 
the specified user has not been granted the right to "Log on as a service" in 
the Local Security Policy.

Figure 100  Setup Complete

15. Click Finish. If there had been a previous installation of CAMIO, or if certain files were 
overwritten during installation, the Setup Complete dialog box may also prompt to reboot 
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the system before running CAMIO. Click Yes to reboot immediately, or No to postpone the 
reboot operation

16. To confirm that the ServiceBroker server has been installed and is available as a service:

a. Open the Window’s Control Panel.

b. Double-click on Administrative Tools.

c. Double-click on Services. The Services dialog opens. 

d. Verify that ServiceBroker is in the list of services and has started. if it has not started:

•  Locate CAMIO in the list of Service names and right-click on it. A 
context menu appears. Click on Properties. The CAMIO 
Properties (Local Computer) dialog appears.

•  Click on the Log On tab.

•  Enter your User Name. Use the Browse function to locate your 
User Name.

•  Enter your password in the Password and Confirm password 
fields.

•  Click on OK.
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SETTING the LICENSE CODE
After CAMIO server has been installed, the following setups must be performed.

To use CAMIO server, the License Code must be entered:

1. In a Web browser, go to http://<camio server name>:8080/CAMIO/Diagnostics/license.tsp, 
where <camio server name> is the name or IP Address of the CAMIO server.

2. If prompted, enter the User (default: Admin) and Password (default: Admin). Otherwise, 
continue to the next step.

The CAMIO Licensing Manager page (Figure 101) is displayed.

Figure 101  CAMIO Licensing Manager

3. Enter the License Key provided by Chyron, and then click Install License Key. The 
CAMIO server is now activated.
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REGISTER CAMIO SERVER with the NEWSROOM SYSTEMS
The ENPS or iNEWS newsroom system must be installed before registering the CAMIO server.
The CAMIO server must then be registered with the newsroom system in order for it to be
recognized as a MOS system.

ENPS

To configure the CAMIO server to be recognized as a MOS server in ENPS:

1. Connect to an existing ENPS client as a privileged user.

2. In any ENPS client application, click the Corporate Folder rover, select System 
Maintenance, and then select MOS Configuration. The MOS Configuration window is 
displayed. Access System Maintenance may be restricted depending on administrative 
privileges.

3. Click New, then enter the following CAMIO server specifications. All other settings should 
be left blank.

4. When complete, click Save. The CAMIO server is now registered with ENPS.

5. Restart the ENPS application.

iNEWS

To configure the CAMIO server to be recognized as a MOS server in iNEWS:

1. On the iNEWS Gateway server, locate the file mosconfig.xml. Add a new <mosDevice> 
tag with values that reflect the new CAMIO installation. Refer to the INEWS MOS 
Configuration guidelines provided with the iNEWS software.

2. In any iNEWS client application, open the System folder, then edit MAP and MOS-MAP.

The System folder is visible only if the user has administrative
privileges.

ID Host name of the CAMIO server; e.g., CAMIOSERVER

Description Host name of the CAMIO server; e.g., CAMIOSERVER

IP IP Address of the CAMIO server; e.g., 192.168.110.130

ActiveX chymox.AssetBrowser.1

Program Group name created in ENPS for the Chyron users.

Local DragDrop Off
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CAMIO SERVER SETUP
Perform the following setups within CAMIO Server Administration.

• Set up CAMIO MOS Administration to configure the systems with which CAMIO 
Server is to communicate. See “CAMIO MOS MANAGEMENT” on page 46.

• Set up a Context in CAMIO Context Administration. See “CAMIO Context 
Manager” on page 64.

• Set up a user in CAMIO User Administration and give the user access to the 
Context. See “CAMIO USER MANAGEMENT” on page 70.

• Set up recognized file formats in CAMIO Mime Type Administration.

Additional CAMIO Administration setups can be performed later in the setup process.

INSTALLING the SQL DATABASE ENGINE (MSDE)
CAMIO now uses SQL databases for LUCI assets not Access databases (MDB format). 
Therefore, databases will not be created in Lyric where they would automatically take the MDB 
format. 

To install the SQL Database engine (MSDE):

a. If you don't already have the install file, you can find it on the Microsoft Website at: 
http://www.microsoft.com/sql/msde/downloads/default.asp. 

b. Once at the website, click Download MSDE 2000 Release A.

c. Select a Language from the drop-down list, and click GO.

d. At the bottom of page, under the heading Files in This Download, click on 
MSDE2000A.exe. The File Download dialog appears.

e. Click Run. After the file has downloaded, unzip contents to C:/MDSERelA.

f. In C:/MDSERelA go to the setup.ini file and enter the following after the line 
[options]. 

SAPWD="<password of Administrator user that CAMIO logs in as>"

g. Double-click on setup.exe to install.

h. Once installed you will see a new icon for SQL at the lower right corner of the desktop 
near the clock. Open this and press the start button. This should automatically start on 
a system restart.

INSTALLING LYRIC
Install Lyric. See “INSTALLING LYRIC and ASSOCIATED TASKS” on page 10.
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REGISTERING LYRIC as a SERVER
This step is required if CAMIO is running as a System Service or as a User Application and you do 
not wish to manually start Lyric. 

It is recommended that Lyric is registered as a server to minimize
interruption with LUCI Previews. This is because Lyric will
automatically load when required by LUCI if it is not already running. 

Close all instances of Lyric before 
continuing.

1. Start the Lyric Server Configuration Utility (Figure 102) by selecting 
Start>Programs>Chyron>Camio>Lyric Server Configuration Utility.

Figure 102  Lyric Server Configuration Utility
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2. Click Register Lyric. The Open dialog box appears (Figure 103). 

Figure 103  Open Dialog

3. Use the Look in drop-down list box (Figure 104) to navigate to c:\program 
files\chyron\lyric 7.0, containing the executable Lyric.exe. 

Figure 104  Lyric Executable

4. Click the Open button, the ServerConfig dialog box (Figure 105) appears. 

Figure 105  ServerConfig
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5. Click Yes.

6. A dialog box (Figure 106) appears indicating that the Lyric plug-in was successfully 
registered. Click OK, to complete the registration.

Figure 106  Successfully Registered Lyric Plug-In

7. Start Lyric. Set the XML Export parameters. See “INSTALLING the NEW ASSET 
MANAGER” on page 19.

INSTALLING LUCI
Install LUCI. See “LUCI INSTALLATION” on page 8.

FINISHING UP

•  Uninstall the IE Enhanced security measures entry.

To do this:

1. Open the Windows Control Panel. Double-click on Add or Remove Programs. The Add 
or Remove Programs dialog displays.

2. In the Add or Remove Programs dialog left panel, click on the Add/Remove Windows 
Components icon. The Windows Components Wizard opens. 

3. Uncheck the IE Enhanced security measures entry.

•  Install all the fonts on the CD (that comes with Lyric-based systems) to the 
Windows Fonts directory located on the CAMIO server.
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APPENDIX C: GLOSSARY

Term Meaning

Context A Context is a group of templates and images that are used on a show or 
group of shows. Contexts are created and assigned specific playback 
hardware channels using the AdminTool Contexts menu.

Groups Groups make it easier to manage access rights to large numbers of users.   

LUCI Lyric Universal Control Interface

Lyric Message A Lyric message is a Template Data Message.

MOS Object A MOS object consists of a Template Data Message and metadata.

Template A Template’s technical name is Template Description Message. The 
Template Description Message is a Lyric message that contains 2D Text 
Template fields and/or 2D Object (Image) Template fields. Template 
Description Messages act as templates on which customized graphics 
can be quickly created on remote PCs and sent for playout on a Lyric-
based system.

Template Data 
Message

Created from templates (Template Description Messages), a Template 
Data Message is a Lyric message that specifies text that is to populate 
specified 2D Text Template fields and/or 2D objects (images) that are to 
populate specified 2D Object Templates, as well as data specifying an 
association with a Template Description Message. When the Template 
Data Message is recalled (read), the associated Template Description 
Message is displayed. Its 2D Text Template fields display the text speci-
fied in the Template Data Message., as well as the 2D objects (images) 
specified in the Template Data Message.

Trustee A Trustee is a Group that has access rights to a Context. 

Users CAMIO keeps a list of users that require access to LUCI via the newsroom 
computer system. 
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APPENDIX D: CHANNEL ASSIGNMENTS for LYRIC 
TEMPLATES in CAMIO

Lyric templates used in the CAMIO MOS System can be assigned default channel assignments 
that control how they play back to air.   

This feature is provided because it is common for different types of graphics to playback from 
different channels in news production. For instance, lower-third name supers would play out of 
channel 1, while over-the-shoulder graphics would play out of channel 2. Sometimes graphics are 
played out of monitors on the back wall of the set, and these may be played back on channel 3, 
etc.

VIRTUAL CHANNEL vs. PHYSICAL CHANNEL
The Lyric Template is assigned a virtual channel value (A, B, C or D, for example) An unassigned 
template has the virtual channel assignment "*".   

In CAMIO Admin Tools, the administrator must create a lookup table that assigns physical 
channels on a specific playout machine to correspond with each virtual channel used by the 
templates. That is what determines which channel and playout machine a template will play to. 
See “ASSIGNING VIRTUAL CHANNELS” on page 66. 

ASSIGNING VIRTUAL CHANNELS in LYRIC 
To assign virtual channels:

1. Right click on Global Light in the Scene Graph.

2. Select MOS. This bring up the MOS properties menu.

3. Select the Technical Info tab and enter the virtual channel assignment (e.g., A, B, C or D) 
into the Channel Text box.

4. Click OK and Save. 

Important

Lyric must have the XML plug in installed in the plug-ins
directory.

OVERRIDING VIRTUAL ASSIGNMENTS of MOS OBJECTS IN LUCI
It is possible to override the virtual channel assignment of the Template when creating a MOS 
Object in LUCI, either before inserting the object or by editing it. This only changes the channel 
assignment of that one MOS Object, it does not change the channel assignment of the Template 
Description Message itself.

To override the virtual channel assignment: 

1. Right click on the right hand pane in LUCI.

2. Select Channel. The current channel assignment will display in the drop-down box. A 
blank current channel assignment means that the channel is unassigned.
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3. Select the channel assignment you want from the drop-down box.   

CHANGING VIRTUAL ASSIGNEMENTS in ASSET MANAGER
It is possible to change the virtual channel assignment of the templates in Asset Manager.

See “CHANGING VIRTUAL ASSIGNMENTS” on page 107.
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APPENDIX E: RESTORING from a BACKUP FILE

INTRODUCTION
CAMIO is set by default to run a dir_backup script every night at 1.30 am. This action will copy all 
the settings of the sb.stg and will enable an administrator to restore stg setting should something 
become corrupted.

The backup files are stored in the c:\program files\chyron\camio\bak folder and are named in 
the format [year.month.day.hour.minute.second].xml, where each of the values is in a two digit 
format. 

For example:

05.12.31.01.30.00.xml

is December 31st, 2005 at 1.30 am).

EDITING CURRENT MESSAGE NUMBER
The restore process changes the working values of the CAMIO server to those values existing at 
the time the backup file was generated. When restoring, be aware that the Current Context 
Message Number in the backup file may not be the last message number used by that context 
when generating MOS Objects, since graphics may have been created after the backup file was 
generated. The backup file must be edited, to ensure that when it is restored, it will start generating 
messages at an appropriate number.

Important

Edit the backup file, to ensure that when it is restored, it will
start generating messages at an appropriate number.

To edit the backup file (to change the context message number), follow these steps:

1. Locate the .XML backup file you wish to restore to in the c:\program 
files\chyron\camio\bak directory.

2. Find the part of the XML code that has the following information. This example is for a 
context called BBTEST. 

Important

You will have to edit this for each context in the CAMIO
server.
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</bmml:resource>
            <bmml:resource name="object119" xsi:type="dir:object" object="BBTEST" par-
ent="/CAMIO/Contexts" schema="ResourceContext" uuid="5B1A7BB9-736F-4A77-
B8B7-5E10E255368E">
                <bmml:properties namespace=""/>
                <dir:property property="Host"/>
                <dir:property property="SocketPort">0</dir:property>
                <dir:property property="VolumePath"/>
                <dir:property property="Title">BBTEST</dir:property>
                <dir:property
 property="MainVolumePath">c:\CAMIO\BBTEST</dir:property>
                <dir:property property="DataSource">dsn://BBTEST</dir:property>
                <dir:property property="RunningOrder"/>
                <dir:property property="CompositionType">lyric/data</dir:property>
                <dir:property property="Style">Basic</dir:property>
                <dir:property property="Enabled">1</dir:property>
            <dir:property property="ObjectCount">50001</dir:property>
            </bmml:resource>

The number of the Current Message Number is located after this code:

<dir:property property="ObjectCount">

3. Change the message number to a number clear of any objects that may have been 
generated since the backup file was created.

4. Resave the XML file. 

PERFORMING RESTORE from BACKUP FILE
To perform a restore from a backup file, perform the following steps:

1. Stop the CAMIO service from the Control Panel>Administrative Tools>Services 
window.

2. Delete the current sb.stg.

3. Copy the backup file you wish to use to the servicebroker.exe directory (c:\program 
files\chyron\camio).

4. In the command prompt, navigate to the Servicebroker.exe path (c:\program 
files\chyron\camio).

5. Type in servicebroker.exe -r [name of backup file]. 

6. Press Enter and the service will be restarted using the XML backup file. It will show the 
process in the command prompt window. The process may take several minutes.

7. Once you see System ready, you can close the command prompt window and restart 
CAMIO from the Services window.
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APPENDIX F: CAMIO ASSET MANAGER (legacy)

OVERVIEW
The Asset Manager is a powerful tool in CAMIO for managing graphics and Lyric templates (also 
referred to as assets). It can be used as part of the MOS newsroom system for managing MOS 
assets or for management and distribution of assets independent of a MOS newsroom system. 

The Asset Manager allows users to browse and manage graphics both locally and remotely on
CAMIO connected systems. Assets can be viewed, sorted, edited, copied, deleted, and
downloaded. A virtual folder hierarchy enables simple, yet sophisticated organization.

GETTING STARTED
If you have not already done so, install the Asset Manager. 

INSTALLING ASSET MANAGER

To install Asset Manager:

1. Open Internet Explorer.

2. Enter the following URL: http://<CAMIO_SERVER>:8080/CAMIO/AssetManager.html 
(8080 is the data connection port used by CAMIO and <CAMIO_SERVER> is the name of 
the Chyron MOS server). 

INSTALLING JAVA
Before installing JAVA, check If there is an older version of Java installed on the client PC, remove 
it, to ensure that the proper version is loaded. 

To do this:

1. Open the Windows Control Panel. Double-click on Add or Remove Programs. The Add 
or Remove Programs dialog displays.

2. Check that the version of the Java Runtime currently installed is J2SE Runtime 
Environment 6.0 or higher (Java 1.5 for Mac). If it is not, remove it.

3. From the client workstation, log on to the CAMIO Server from Internet Explorer using the 
URL: http://camioserver:8080/CAMIO/AssetManager.html (8080 is the data connection 
port used by CAMIO and camioserver is the name of the Chyron MOS server). The 
CAMIO Server automatically loads the Java Runtime.
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SETTING JAVA POLICY
1. Double-click on the Java Policy Tool (policytool.exe) located in C:\program 

files\java\<version number>\bin. The Policy Tool (Figure 107) is displayed.

Figure 107  Java Policy Tool

2. Click Add Policy Entry. The Policy Entry dialog (Figure 108) appears.

Figure 108  Policy Entry Dialog

3. In the CodeBase input field, enter http://<CAMIO_SERVER>/* (where 
<CAMIO_SERVER> is the network name of the camio server). 
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4. Click on Add Permission. From the Permission drop-down list (Figure 109), select All 
Permissions.

Figure 109  Permission Drop-down List

5. Click OK, to close the Permissions dialog. 

6. Click Done, to close the Policy Entry dialog.

7. Repeat steps 2 through 6, entering http://localhost/* in the CodeBase input field in step 
3 (Repeating these steps for localhost only needs to be done when installing Asset 
Manager on the CAMIO Server).

8. From the Policy Tool File menu, select Save As. The Save As dialog is displayed.

Save this file as .java.policy (remember the period in front of java) in the c:\documents and 
settings\<your login> folder. <your login> is the username that Windows is logged in as.

CONNECTING to a LOCAL HOST (from the CAMIO server)

The Service Broker must be running, to 
access the Asset Manager.

1. Open a Web browser.

2. Enter the following URL: http://localhost:8080/CAMIO/assetmanager.html (8080 is the 
data connection port used by CAMIO), or click on Start>All 
Programs>Chyron>Camio>Asset Manager.
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3. Click Enter or Go. To Open the Login Window click on Open System; the Login window is 
displayed (Figure 110).

Figure 110  CAMIO Asset Manager Login Window

4. Enter the CAMIO server name (or localhost if opening Asset Manager from the CAMIO 
server), a user name, and password.

5. Click OK. The Asset Manager is displayed (Figure 111).

Figure 111  CAMIO Asset Manager
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CONNECTING to a REMOTE HOST (from a remote computer)
The Asset Manager can be accessed using a URL that contains either the System Name or IP 
Address, as shown below:

http://<CAMIO_Server>:8080/Camio/assetmanager.html

or 

http://<IP address>:8080/Camio/assetmanager.html

For example, the following URLs for the server CAMIO-R1 with an IP Address of 10.10.2.204 
would be valid:

http://camio-r1:8080/Camio/assetmanager.html

http://10.10.2.204:8080/Camio/assetmanager.html
138



ASSET MANAGER INTERFACE
The Asset Manager Interface (Figure 112) consists of the following components:

Figure 112  ASSET MANAGER INTERFACE

Menu Bar - descriptions of the menus are provided below.

File Menu (Figure 113)

Figure 113  File Menu 

MENU BAR

SERVER/CONTEXT WINDOW ASSET DISPLAY WINDOWSTATUS LOG WINDOW
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View Menu (Figure 114)

Figure 114  View Menu

Open System... Displays the New System dialog, when selected. 
Enter a CAMIO server Host Name, User Name, 
and Password, then Click OK. to connect to a new 
system.

New Window Opens a new window, when selected.

Bookmark System Remembers systems currently connected. When 
Asset Manager is next opened, 

Reload Bookmark Reloads the bookmark.

Exit Select to exit Asset Manager.

Replications Displays the replications window that dis-
plays all replications on the connected 
servers.

Status Log Displays the Status Log.
140



Asset Table Menu (Figure 115)

Figure 115  Asset Table Menu

Server/Context Window (Figure 116) - displays the various servers on the system, Context icons, 
and any Context sub-folders. 

Figure 116  Server/Context Window

Asset Display Window - displays Context assets. 

Status Log Window - displays the status log. A plus sign to the left of the Context icon indicates 
that there are sub-folders in that Context. Clicking on the plus sign will expand the view and allow 
you to browse the sub-folders. 

Using Context sub-folders provides a convenient way to organize different types of assets within a 
Context. The recommended folder hierarchy, shown below, matches the Lyric browser hierarchy.

•  messages
•  images

•  XClyps

•  videos

Large Icons Click to display large icons.

Select All Click to select all items.

Clear Selection Click to clear selected items.

SERVER
ICONS

CONTEXT
ICON

CONTEXT
SUB-FOLDERS
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WORKING in ASSET MANAGER
ENTERING ASSETS
ENTERING ASSETS ONE at a TIME
Any file type can be entered in Asset Manager. Simply drag and drop the file into the Asset Display 
window. The New Asset Details dialog (Figure 117) is displayed. Use this dialog to enter 
meaningful metadata about the asset in the Subject, Keywords, and Comments fields. When 
done entering metadata, click on Upload. The new asset is then uploaded to the Asset Manager, 
and a thumbnail image of the asset is displayed in the Asset Display window, along with the 
accompanying metadata.

Important

It is important that meaningful metadata is entered to
facilitate searching the asset database at a later time.   Asset
Manager has a search tool that allows you to search for files
using this metadata. The metadata is also used by the
newsroom to conduct searches in LUCI.

Figure 117  New Asset Details Dialog
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ENTERING MORE THAN ONE ASSET at a TIME

Simply drag and drop the selected files onto the Asset Display window (Figure 118). 

Figure 118  Asset Display Window

The New Asset Details dialog (Figure 119 on page 144) is displayed. Use this dialog to enter 
meaningful metadata about the assets in the Subject, Keywords, and Comments fields.

See “ASSET FORMATTING” on page 57 for a listing of format strings
you can use.

Selecting the Use As Template For All Files checkbox applies the metadata you enter to all 
selected files. Leaving Use As Template For All Files unchecked, allows you to enter metadata 
separately for each of the selected files.

When done entering metadata, click on Upload. The new assets are then uploaded to the Asset 
Manager. A thumbnail image of each asset is displayed in the Asset Display window along with the 
accompanying metadata.
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Figure 119  New Asset Details—Use AS Template For All Files

STORING IMAGE FILES and LYRIC TEMPLATES
Asset Manager handles the storing of image files and Lyric templates as follows:

Image Files
An image file will generate a thumbnail image when entered into Asset Manager. These 
thumbnail images will also be displayed in LUCI’s Image Browser when the applicable Context 
is selected.

Lyric Templates
To use Lyric templates in LUCI, they must have been previously saved with XML. See Saving 
Lyric Templates with XML, below. Asset Manager will report an error in the Status Window, if 
you try to store a .lyr file that does not have XML in it.

SAVING LYRIC TEMPLATES with XML
In order to enter Lyric templates into Asset Manager, they must have been previously saved with 
XML. To do this, save the template in Lyric. Lyric must be running on a template creation 
workstation that has the XML and MOS plug-ins installed and configured correctly. See 
“INSTALLING the NEW ASSET MANAGER” on page 19. The template creation workstation can 
be an offline Lyric system or a Lyric-based system. The template creation workstation should not 
be on the CAMIO server. 

The template creation workstation can be an offline Lyric system or a 
Lyric-based system. The template creation workstation should not be 
on the CAMIO server. 
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CONTEXTS
Clicking on a Context icon will display all the assets in the Asset Display window. A plus sign to the 
left of the Context icon (Figure 120) indicates that there are sub-folders in that Context. Clicking on 
the plus sign will expand the view and allow you to browse the sub-folders. 

Figure 120  Click to View Subfolders

CONTEXT SUBFOLDERS
Using Context subfolders offers a convenient way to organize different types of assets within a 
Context. It is recommended to create and name folders that match the content that will be 
uploaded.

Adding a New Folder

To add a new folder:

1. Right-click on the Context. 

2. Select New Folder from the context menu that appears. The Create Folder dialog 
appears (Figure 121). 

Figure 121  Create Folder

3. Enter the name of the new folder. 

4. Click OK.

To use Lyric templates in LUCI, they must have been previously saved with XML. Asset Manager 
will report an error in the Status window if you try to store a .lyr file that does not have XML in it.

DELETING OBJECTS
To delete an object from a Context, right-click on the object and select Delete. The object will then 
be moved into the Trash bin and may be deleted from there. To delete the contents of the Trash 
bin, right-click on the Trash bin and select Empty Trash.

CLICK TO
EXPAND
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To delete an object without moving it to the Trash bin, hold down the Shift key, while performing 
the delete operation. This operation cannot be undone.

EDITING OBJECT PROPERTIES
Object properties can be edited once an object has been uploaded by right clicking on the object 
and selecting Properties. The Properties dialog appears with the General tab selected by default 
as shown in Figure 85. The Properties dialog allows edits to be made to the metadata as well as 
offering the ability to change Virtual channel assignments and snap frames. See below for detailed 
descriptions of these tabs. 

General Tab (Figure 122) - The General tab displays the Lyric message number, type of file, 
Lyric build number, and other pertinent file information including if files were saved with XML 
(see Attributes).

Figure 122  Properties—General Tab
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Summary Tab (Figure 123) - The Summary tab provides Title, Subject, Author, Keywords, 
and Description fields that may be edited.

Figure 123  Properties Dialog—Summary Tab

MOS Tab (Figure 124) - The MOS tab provides various fields for editing.

Figure 124  Properties Dialog—MOS Tab
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UPLOADING REPLACEMENTS
When an object is uploaded to the CAMIO server using Asset Manager, it is automatically 
assigned a GUID (Globally Unique ID). If an object is deleted, the GUID is also deleted. If an 
existing object needs to be replaced, it is best practice to upload a replacement by right clicking on 
the object and selecting Upload Replacement from the context menu (Figure 125).

Figure 125  Upload Replacement

The following example should make this clear.

Example: A new lower third has been created to replace the current lower third. All new and 
existing LUCI objects should use this new message. You should select Upload Replacement, 
rather than Delete. If you delete the old object, then any LUCI objects created from that object 
will still play out with the old content. Only if Upload Replacement is used will all LUCI objects 
reflect the change. 

Important

If an object is deleted from the Asset Manager, the
newsroom should refresh their LUCI browser to ensure that
their LUCI browser is not offering any objects that are no
longer available. If an image has been deleted from a Context
using Asset Manager and LUCI has not been refreshed, it is
possible for the newsroom to preview a graphic correctly
even if the image no longer exists.
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CHANGING VIRTUAL ASSIGNMENTS
To do this:

1. Select a Template.

2. Right click and select the MOS tab from the properties page.

3. Edit the Channel text box.

CHANGING SNAP FRAME
To do this:

1. Select a Template.

2. Right click and select the MOS tab from the properties page.

3. Select new Snap Frame.
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APPENDIX G: MIME TYPES
The following list of MIME types is provided for the benefit of the user. Note, however, that Chyron 
does not support many of the listed file formats.    

MIME TYPES

FILE EXTENSION

323 text/h323 

acx application/internet-property-stream 

ai application/postscript 

aif audio/x-aiff 

aifc audio/x-aiff 

aiff audio/x-aiff 

asf video/x-ms-asf 

asr video/x-ms-asf 

asx video/x-ms-asf 

au audio/basic 

avi video/x-msvideo 

axs application/olescript 

bas text/plain 

bcpio application/x-bcpio 

bin application/octet-stream 

bmp image/bmp 

c text/plain 

cat application/vnd.ms-pkiseccat 

cdf application/x-cdf 

cer application/x-x509-ca-cert 

class application/octet-stream 

clp application/x-msclip 

cmx image/x-cmx 

cod image/cis-cod 

cpio application/x-cpio 

crd application/x-mscardfile 

crl application/pkix-crl 
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crt application/x-x509-ca-cert 

csh application/x-csh 

css text/css 

dcr application/x-director 

der application/x-x509-ca-cert 

dir application/x-director 

dll application/x-msdownload 

dms application/octet-stream 

doc application/msword 

dot application/msword 

dvi application/x-dvi 

dxr application/x-director 

eps application/postscript 

etx text/x-setext 

evy application/envoy 

exe application/octet-stream 

fif application/fractals 

flr x-world/x-vrml 

gif image/gif 

gtar application/x-gtar 

gz application/x-gzip 

h text/plain 

hdf application/x-hdf 

hlp application/winhlp 

hqx application/mac-binhex40 

hta application/hta 

htc text/x-component 

htm text/html 

html text/html 

htt text/webviewhtml 

ico image/x-icon 

ief image/ief 

iii application/x-iphone 

MIME TYPES
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ins application/x-internet-signup 

isp application/x-internet-signup 

jfif image/pipeg 

jpe image/jpeg 

jpeg image/jpeg 

jpg image/jpeg 

js application/x-javascript 

latex application/x-latex 

lha application/octet-stream 

lsf video/x-la-asf 

lsx video/x-la-asf 

lzh application/octet-stream 

m13 application/x-msmediaview 

m14 application/x-msmediaview 

m3u audio/x-mpegurl 

man application/x-troff-man 

mdb application/x-msaccess 

me application/x-troff-me 

mht message/rfc822 

mhtml message/rfc822 

mid audio/mid 

mny application/x-msmoney 

mov video/quicktime 

movie video/x-sgi-movie 

mp2 video/mpeg 

mp3 audio/mpeg 

mpa video/mpeg 

mpe video/mpeg 

mpeg video/mpeg 

mpg video/mpeg 

mpp application/vnd.ms-project 

mpv2 video/mpeg 

ms application/x-troff-ms 

MIME TYPES
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mvb application/x-msmediaview 

nws message/rfc822 

oda application/oda 

p10 application/pkcs10 

p12 application/x-pkcs12 

p7b application/x-pkcs7-certificates 

p7c application/x-pkcs7-mime 

p7m application/x-pkcs7-mime 

p7r application/x-pkcs7-certreqresp 

p7s application/x-pkcs7-signature 

pbm image/x-portable-bitmap 

pdf application/pdf 

pfx application/x-pkcs12 

pgm image/x-portable-graymap 

pko application/ynd.ms-pkipko 

pma application/x-perfmon 

pmc application/x-perfmon 

pml application/x-perfmon 

pmr application/x-perfmon 

pmw application/x-perfmon 

pnm image/x-portable-anymap 

pot, application/vnd.ms-powerpoint 

ppm image/x-portable-pixmap 

pps application/vnd.ms-powerpoint 

ppt application/vnd.ms-powerpoint 

prf application/pics-rules 

ps application/postscript 

pub application/x-mspublisher 

qt video/quicktime 

ra audio/x-pn-realaudio 

ram audio/x-pn-realaudio 

ras image/x-cmu-raster 

rgb image/x-rgb 

MIME TYPES
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rmi audio/mid 

roff application/x-troff 

rtf application/rtf 

rtx text/richtext 

scd application/x-msschedule 

sct text/scriptlet 

setpay application/set-payment-initiation 

setreg application/set-registration-initiation 

sh application/x-sh 

shar application/x-shar 

sit application/x-stuffit 

snd audio/basic 

spc application/x-pkcs7-certificates 

spl application/futuresplash 

src application/x-wais-source 

sst application/vnd.ms-pkicertstore 

stl application/vnd.ms-pkistl 

stm text/html 

svg image/svg+xml 

sv4cpio application/x-sv4cpio 

sv4crc application/x-sv4crc 

swf application/x-shockwave-flash 

t application/x-troff 

tar application/x-tar 

tcl application/x-tcl 

tex application/x-tex 

texi application/x-texinfo 

texinfo application/x-texinfo

tgz application/x-compressed 

tif image/tiff 

tiff image/tiff 

tr application/x-troff 

trm application/x-msterminal 
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tsv text/tab-separated-values 

txt text/plain 

uls text/iuls 

ustar application/x-ustar 

vcf text/x-vcard 

vrml x-world/x-vrml 

wav audio/x-wav 

wcm application/vnd.ms-works 

wdb application/vnd.ms-works 

wks application/vnd.ms-works 

wmf application/x-msmetafile 

wps application/vnd.ms-works 

wri application/x-mswrite 

wrl x-world/x-vrml 

wrz x-world/x-vrml 

xaf x-world/x-vrml 

xbm image/x-xbitmap 

xla application/vnd.ms-excel 

xlc application/vnd.ms-excel 

xlm application/vnd.ms-excel 

xls application/vnd.ms-excel 

xlt application/vnd.ms-excel 

xlw application/vnd.ms-excel 

xof x-world/x-vrml 

xpm image/x-xpixmap 

xwd image/x-xwindowdump 

z application/x-compress 

zip application/zip 
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